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Introduction 
Creating Futures is a 4-year project funded by the New Zealand Foundation for 
Research, Science and Technology (FRST). The project brings together an 
interdisciplinary team consisting of a key end user (Waikato Regional Council, WRC) 
and social, environmental and economic researchers. The project aims to develop new 
methods and tools to support integrated, long-term planning by 1) developing 
processes to evaluate, deliberate, and choose futures through scenario analysis and 
multi-criteria deliberation frameworks and 2) develop an integrated spatial decision 
support system (ISDSS) to support the evaluation and deliberation processes. 
Together these tools will help Waikato Regional Council and other councils evaluate 
links and trade-offs between economic, environmental and social/cultural outcomes 
and the cumulative effects of many decisions over space and time. 
 
An ISDSS is an Integrated Spatial Decision Support System designed to help examine 
weakly-structured or unstructured problems characterised by many actors, many 
possibilities, and high uncertainty. The Waikato Integrated Scenarios Explorer, or 
WISE, is being developed for the Waikato region to support evaluation and deliberation 
of strategies and scenarios related in the context of Waikato Regional Council‟s long-
term planning. 
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User Manual – An Overview 
This is an overview of the user manual for WISE, an integrated spatial decision support 
system built with the GEONAMICA framework. WISE is developed for the Waikato 
region to support Waikato Regional Council‟s long-term council community planning 
process. 
 
This manual contains five sections: 
Section 1 “Getting started” explains how to install WISE on your computer and how to 
start the program. It also describes the main features of the graphical user interface. 
 
Section 2 “Running the simulation” contains a step-by-step description of how to run a 
simulation in WISE. 
 
Section 3 “Policy interface” describes the steps that a policy user should follow to carry 
out an integrated impact assessment with WISE. 
 
Section 4 “Modeller interface” describes the interface for a modeller to access the 
underlying models and to update data and parameter settings through the system 
diagram in WISE. 
 
Section 5 “The WISE menu system” offers a systematic description of each option in 
the menu system. 
 
Through this documentation, for the convenience of the user, a special arrow symbol  
is used in a step-by-step description of how to complete the action that you can follow 
along at your computer.  For example:  
 
 Click Open project on the File menu. 
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1. Getting started 
This chapter explains how to install WISE on your computer and how to start the 
program. It also describes the main features of the graphical user interface. 

1.1 Computer requirements 

WISE runs on personal computers running Microsoft Windows XP and equipped with 
modern Intel or Intel compatible processors. It may also run on Windows Vista and 
Windows 7, but has only been fully tested on Windows XP. To use WISE, your 
computer should have the following hardware components: 

 At least 1GB of RAM 

 A hard disk with at least 10GB free space 
 
To use WISE, you should have the following software packages installed on your 
computer: 

 Microsoft® Excel (version 2003 or later) (required) 
 
If you experience problems when installing WISE, you can contact RIKS (see the 
section If you experience problems). 

1.2 Installing WISE and accompanying tools 

The following is a step-by-step description of the installation of WISE. The 
installation/uninstallation of WISE follows standard Windows procedures. 
 
If you have a previous version of the WISE software installed on your machine, you will 
be asked whether you want to uninstall it first. We recommend uninstalling it. If you 
want to keep it, make sure to put the latest version of WISE in a separate folder. During 
the installation you may encounter a message asking whether you want to keep or 
replace certain files. We recommend replacing those files for use with WISE. Keeping 
the old files may cause the software to malfunction. 
 
To Install WISE: 
 
 Step 1. Start Microsoft Windows XP. 
 
 Step 2. Download or copy the WISE setup. 
 
 Step 3. Double-click on the WISE_#.#.#_setup.exe. The #.#.# refers to the version 

number of the software installation. 
 
 Step 4. Follow the steps on the screen to install the software and data. 
 
 Step 5. (Optional) Download the Map Comparison Kit from http://www.riks.nl/mck. 

Install it by double-clicking the downloaded file and follow the steps on the screen. 
 
To uninstall WISE: 
 
 Step 1. Open the Control Panel (this is normally available in the Windows Start 

menu). Open „Add or Remove Programs‟ in the Control Panel. Next click the 
change or remove programs button in the Add or Remove Programs Properties 
dialog window. 

 
 Step 2. Select WISE from the list of applications and press the Change/Remove 

button. 
 

http://www.riks.nl/mck
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 Step 3. The Confirm File Deletion dialog window will open. Press the OK button to 
confirm that you want to remove WISE and all its files from your hard disk. 

 
 Step 4. Repeat the steps 1 to 3 to uninstall the Map Comparison Kit. 

1.3 Starting WISE 

Once installed, you can start the WISE application as follows: 
 Click the Start button on the Windows taskbar 
 Go to All Programs → Geonamica → WISE. 
 Click on WISE. 

Importing the license file 

The first time you start WISE a dialog window will appear asking you to install a licence 
file for WISE. Once a license is installed, the software will skip this step, unless the 
installed license has expired. 
 Click the OK button on the message window. 
 
A dialog window will open allowing you to navigate to the folder where you put the 
licence file for WISE that you have received. 
 Open the licence file with the extension .lic. 
 
Each time you start WISE, the About window appears (see the section About). 
 Click the OK button on the About window. 

Opening the project file 

 After you press the OK button on the About window, the Open project file dialog 
window opens.  

 Navigate to the project file that you want to open and double-click on it. 
 
If the project file you want to open is created with an older version of WISE, a message 
window will appear to ask you whether to upgrade the project file to the current version 
of software.  

 Click the No button if you still want to be able to open the project with an earlier 
version of the software. 

 Click the Yes button to upgrade the project file automatically. Then you can open it 
with the current version of WISE. You will no longer be able to open the project with 
an earlier version of the software. 

 
WISE will be started and you will see the WISE - ### application window on your 
screen, where “###” is the name of the project file that you selected. 

1.4 Screen layout 

When you start WISE, the application window opens immediately. This is the window in 
which you will run your simulations. You can arrange windows as you like in the 
application window. Before a project file has been opened, the window is empty except 
for its Status bar, Toolbar and Menu bar. The different components of this window will 
be described in the next paragraphs. 
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The Menu Bar provides access to various functions in WISE. Each menu item is 
described in detail in the section The WISE menu system. 
 
The Toolbar gives fast access to some of the more frequently used functionality. Each 
item on the toolbar is described in the table below. 
 

Item Function 

 Open a project file from the disk. 

 Save the opened project file to disk. 

 

Displays the active integrated scenario. The dropdown 
list shows all the available integrated scenarios. You 
can load an integrated scenario by selecting it from 
the dropdown list. 

 Advance the simulation with one simulation step. 

 Advance the simulation till the next pause is reached. 

 Stop the simulation after the current step is finished. 

 Reset the simulation to the initial year. 

 
Displays the current simulation time whenever a 
project is open. 

 
The Status bar is displayed at the bottom of the application window. It contains different 
sections that provide different kinds of information: 

 The leftmost section provides general information. When you navigate through the 
menu, it describes the selected menu item. 

 The second section from the left provides local information when you move the 
mouse over a map. For a raster map, it lists the cell index and the value in that cell. 
For network maps, it lists the x and y coordinates of the location. 

 The third section from the left displays a progress bar while the model is 
calculating. 

 The rightmost sections of the Status bar indicate which of the following keys are 
latched down: the Caps Lock key (CAP), the Num Lock key (NUM), or the Scroll 
Lock key (SCRL). 

Status bar 

Toolbar 

Application Window 

Menu bar 
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1.5 System Information 

The different commands in the Help menu allow you to look up the system information 
about WISE. For more information see the section Help menu. 

Help 

Click Index on the Help menu (or press the F1 key) to open the on-line help file of 
WISE. Use the Contents tab on the left side of the „WISE User Manual‟ window to 
navigate to the topic that you want help on. You can also use the Search tab to find the 
relevant section in the user manual. If these tabs are not displayed, click the Show  
button at the top of the „WISE User Manual‟ window. 

Licence 

Click Licence on the Help menu to get the licence information in the „Installed licenses‟ 
window. All licences for the Geonamica-based software installed on your computer will 
be listed in the table. You can import a licence file (with extension .lic) by clicking the 
„Read a licence file‟ button. To remove a license, click the „Open license folder‟ button 
and remove the files with the license name you want to remove from the folder. You 
need to restart the application for the changes to take effect. There is no need to 
remove existing licenses before installing a new one. 

Checking for updates 

Click „Check for updates‟ on the Help menu to check if you are using the latest version 
of WISE. If a newer version is available, the system will tell you how to get it. 

About 

Click About on the Help menu to open the About window. Here you can find the 
copyright notice and version number of WISE. The latter is important if you need 
assistance with the software (see the section If you experience problems) or when you 
request an update of the software. 
 

 

Version number 
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1.6 Closing WISE 

You can close WISE by clicking Exit on the File menu. If you have a project file open, 
the application may ask whether you want to save your changes before closing.  
 

 
 
Click the Yes button to save your changes, click the No button to discard your changes 
and close WISE or click the Cancel button to keep WISE open. More information on 
saving changes is available in the section Saving changes.  

1.7 If you experience problems 

If you experience problems installing or running WISE, please contact RIKS with the 
version number of the application that you are using (see the section About): 
 
Research Institute for Knowledge Systems bv. 
To the attention of Hedwig van Delden 
P.O. Box 463, 6200 AL Maastricht, The Netherlands 
Tel: +31 (43) 3501750 
Fax: +31 (43) 3501751 
E-mail: info@riks.nl 
Website: www.riks.nl 
 
 

http://www.riks.nl/
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2. Running the simulation 
This section describes the primary steps of running a simulation with WISE: Opening a 
project file, editing input and displaying output, saving changes, running a scenario, 
saving results and analysing results. 

2.1 Opening a project file 

In the section Getting started, we explained how to install and start WISE. We assume 
from now on that you have read this information, that you have successfully installed 
WISE on your computer and that you have knowledge of the different terms introduced. 

Opening an existing project file 

 Open WISE if it is not already open – see the section Starting WISE. 
 Click the Open button on the toolbar if the „Open project file‟ window is not already 

open. 
 Navigate to the folder where you installed the WISE data and project files. By 

default, this is the folder Geonamica\WISE inside My Documents. 
 Select the Waikato file and click the Open button. 
 
Once all files have been loaded, two windows appear in the application window: the 
Main window and the Land use map. As you will need to use these windows most of 
the time, you cannot close these windows to prevent doing so accidentally. If they are 
in your way, click the Minimize button on the window and it will move to the bottom of 
the application window. 

Main Window 

The Main window is organised in tabs and pages, which are displayed on the left side 
of the window. The Main window has 4 tabs: Drivers, Scenarios, Indicators and 
Analysis. Each tab has one ore more pages, which are displayed as icons when you 
click on a tab. Click on an icon to display a page in the right side of the window, called 
the content pane. 
 

 
 
The Main window provides access to the policy user interface and the modeller 
interface. The section Policy interface and the section Modeller interface provide 
detailed descriptions of interface for these two types of users. 
 

Tabs 

Page Content pane 
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2.2 Editing Input and displaying output 

The models incorporated in WISE use and compute various forms of input and output 
data: spatial, temporal and tabular. These are represented in the graphical user 
interface in different ways to best fit the nature of the data. You will be able to find the 
following elements in the user interface: 

 Maps 

 Graphs 

 Time series 

 Tables 
 
The following sub-sections describe how to edit input and display output for each of 
these elements. 
 

Map window 

Since all map windows in WISE work the same way, we will use the Land use map 
window that is opened when you open a project in WISE as an example. A Map 
window is split into 5 areas, called panes as depicted below. Panes are separated from 
each other by means of splitter bars. You can move the splitter bars to change the size 
of a pane. 

 

Overview pane 

The overview pane displays the entire modelled region. When the map is zoomed in, a 
rectangle is displayed that indicates the area displayed in the map pane. You can drag 
this rectangle to move the view of the map. 

Map pane 

The map pane in the Land use map window displays the land use map for the current 
simulation year. This is a raster map that displays the predominant land use for each 

Layer visibility button Legend pane Layer manager pane 
 

Overview pane Tools pane Map pane 
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cell. When a simulation is running, the Land use map window will be updated after 
each time step. 
 
Right-clicking inside the map pane will display a context menu. Click „Cell information‟ 
on this menu to list the land use and district in the exact cell you right-clicked on. You 
can also access the same information by using the Inspect tool – see the section Grid 
tools. 
 
Double-clicking on the map pane of the Land use map window (this does not work for 
other map windows) opens the „Contingency table Land use map and Districts map‟ 
window that shows the surface area of each land use in each district – see the image 
below. You can select the unit for the surface area from the „Display values in‟ list. If 
you select the „Include cells outside modelling area‟ checkbox, the land use outside the 
modelling area will be displayed in the first column. Otherwise, these values will be 
zero. The last row and column in the table display the totals. 
 

 

Legend pane 

The legend pane is displayed in the upper-left portion of the Map window. It shows the 
legend of the map selected in the layer manager pane (explained below). For example, 
if you select a land use map, the legend pane shows the land use legend. Double-click 
in the legend pane to change the legend that is displayed – see the section Legend 
editor. 
 
Land uses are subdivided into 3 types: Vacant, Function, Feature. In the land use 
legend, the Vacant land uses appear at the top of the list, the Function land uses 
appear in the middle of the list and are underlined, and the Feature land uses appear at 
the bottom of the list. The 3 different land use types are explained in the section Land 
use classes.  

Layer manager pane 

The layer manager pane is displayed in the upper-right portion of a map window.  You 
can select a layer by clicking on its name (note that you cannot select the district 
boundaries layer). This will display the legend for the layer and allow you to edit the 
layer (if possible) – see the section Grid tools and Network tools. You can show or hide 
a layer by clicking on the layer visibility button in the layer manager pane. 
 

Button Function 

 
Layer is visible 

 
Layer is hidden 

Tools pane 

The tools pane is displayed in the lower-right portion of the Map window. It shows the 
tools for viewing and editing maps and includes the Zoom tools, Grid tools, and 
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Network tools. Click on the corresponding name to expand or collapse the section for 
either of these three. 

Zoom tools 

Use the Zoom tools when you would like to see a location in more detail.  
 

Button Function 

 
Click in the map pane to zoom in 

 
Click in the map pane to zoom out 

 
Drag in the map pane to change the viewed 
area 

 
Select an area in the map pane to zoom in 
on 

 
Zoom in/out to fit the entire map in the 
window 

 

Grid tools 

Use Grid tools to edit and view the information of the editable raster or grid maps that 
you have selected. 
 

Button Function 

 

Click in the map pane to change the value of a cell to the item 
selected in the legend pane. This button will be disabled for non-
editable maps. 

 

Click in the map pane to change the value of a patch to the item 
selected in the legend pane. This button will be disabled for non-
editable maps. 

 Click in the map pane to list the value in a cell. 

 Save the map to a file on disk. 

 
If you have changed an editable map using the pen or flood tool, you will be asked if 
you want to save or discard your changes when you close the map window. Your 
changes will not be processed in the model until you close the map window and 
choose to save your change. If you choose to save your changes, make sure you save 
them in a new file and do not overwrite an existing file or, otherwise, the system may 
not process your changes correctly. 
 
From the current land use map, accessible via Drivers → Parameters → Land use→ 
Land use tab → „Show current land use map‟ button, you can derive more information 
by using the Inspect tool. In the Potential figures dialog window that will open, the table 
lists the values for total potential, neighbourhood potential, suitability, numerical zoning 
and accessibility for each land use function for the selected location. The row and 
column index of the location are displayed in the caption of the window. This 
functionality is very useful during calibration. 
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Network tools 

The Network tools become enabled only when a network layer is selected in the layer 
manager pane. In WISE, there are several ways to open a network map window: 
through the Maps menu, through the policy user interface or through the modeller user 
interface. For more details, we refer to the section Creating network changes and the 
section Network map window opened via the modeller user interface, respectively. 
 
You can use the Network tools to view or edit the infrastructure network.  
 

Button Function 

 Left-click on a node or link in the map pane to select it; 
Double-click on a node or link to edit the properties; Change 
the location of a node by dragging it to a new location. 

 Drag in the map pane to draw a new link; the link will be 
drawn as a straight line from the start point to the end point. 
This button will be disabled for the non-editable maps. 

 Left-click in the map pane to add a new node. This button 
will be disabled for the non-editable maps. 

 Select this check box to display nodes of a network in the 
map pane; Clear this check box to not show nodes on the 
network map. 

 
Select this check box to display links of a network in the 
map pane; Clear this check box to not show links on the 
network map. 

 
If you have changed an editable map, you will be asked if you want to save or discard 
your changes when you close the map window. Your changes will not be processed in 
the model until you close the map window and choose to save your change. If you 
choose to save your changes, make sure you save them in a new file and do not 
overwrite an existing file or, otherwise, the system may not process your changes 
correctly. 

Legend editor 

A legend assigns a label and a colour (and possibly other characteristics, such as line 
thickness) to each value in a map. Depending on what the values in a map represent, 
we can either use a categorical or a numerical legend. In a categorical legend, the 
values in the map are assumed to represent category indices, starting with the value 0 
for the first category. An example of a categorical map is the land use map, where the 
land use classes form the categories. The values in a numerical map can, in principle, 
take any value. To limit the amount of entries in a numerical legend, we associate each 
entry with a certain range of values. An example of a numerical map is the annual 
amount of rainfall. 
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Double-click inside the legend pane of a map window to open the legend editor. Here 
you can change the properties of the legend to control how the map is displayed. Each 
distinct legend in WISE is stored as a file on disk; the file name is displayed at the top 
of the Legend editor window. You can click the Import button to copy the properties of 
another legend into the legend you are editing. Note that this does not change the file 
name of the legend you are editing. 
 
You can choose whether a legend represents categorical or numerical data by 
selecting the appropriate entry from the „Legend type‟ list. The other controls in the 
window will update accordingly. The following sections explain how to use them. 

Categorical legends 

When the Legend type in the legend editor is set to Categorical, the window will look 
similar to the image depicted below. You can set the number of classes manually or 
click the „Derive from map‟ button to set the number of classes to the highest value 
found in the map plus one. Note that this button is disabled for the legends of a network 
layer. 
 

 
 
The table displays the categories in the order they will appear in the legend pane. 
Double-click on a label to change it. You can also copy-paste the labels from a text 
editor or Excel. 
 
Click on an entry in the Colour column to change the colour of a category. A dialog will 
pop up where you can select the desired colour. You can also set the colour of all the 
categories by clicking the „Generate colours‟ button – see the section Generate 
colours. 

Numerical legends 

When the Legend type in the legend editor is set to Numerical, the window will look 
similar to the image depicted below. You can set the number of classes by typing the 
desired number or by clicking the up/down arrow buttons. 
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The table displays the classes in the order they will appear in the legend pane. You can 
change the lower and upper bound of each legend class by double clicking on the 
number in the table. When you set the lower bound higher than the upper bound of a 
class, the values will be given a red background to indicate the error. You have to 
adjust the values before you will be able to save the legend by clicking the OK button. 
Click the „Generate class bounds‟ button to set the lower and upper bounds of each 
class according to some scale – see the section Generate class bounds. 
 
Double-click on a label to change it. You can also copy-paste the labels from a text 
editor or Excel. Click the „Generate labels‟ button to set the labels according to the 
values in the lower and upper bound columns – see the section Generate labels. 
 
Click on an entry in the Colour column to change the colour of a category. A dialog will 
pop up where you can select the desired colour. You can also set the colour of all the 
categories by clicking the „Generate colours‟ button – see the section Generate 
colours. 

Generate class bounds 

 
 

 Click the „Generate class bounds‟ button in the legend editor to open the Generate 
class bounds window – see the image above.  

 Click on the Order list to choose the order of legend entries. 
 Enter a Minimum value and a Maximum value or select Choose automatically to set 

these values to the minimum and maximum value in the map. The lower bound of 
the lowest class will be set to the Minimum value. The upper bound of the highest 
class will be set to the Maximum value. 

 Select a scaling method from the Scale list or click the „Find best scale‟ button to 
select the scaling method that yields the highest Estimated effectiveness – this is a 

value between 0% and 100% that indicates how well the classification will be able 
to distinguish the variety of values that occur in the map. The available scaling 
methods are described in the table below. 
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 Click the OK button to update the lower and upper bounds in the legend editor 
window. Note that the labels in the table will not be updated. 

 

Scaling method Description 

Linear Each class will have the same width (i.e. difference between 
lower and upper bound). 

Arithmetic The width of the second lowest class will be twice the width 
of the lowest class. The width of the third lowest class will be 
three times the width of the lowest class. Etc. 

Geometric The ratio of upper bound divided by lower bound will be the 
same for each class. 

Over-geometric The ratio of upper bound divided by lower bound for the 
second lowest class will be twice that of the lowest class; for 
the third lowest class three times that of the lowest class; 
etc. 

Harmonic This scale is useful for data that follows a factorial 
distribution. 

Quantiles Each class will cover an approximately equal amount of 
values. 

Standardised 
discretisation 

The width of each class is set according to the standard 
deviation of the values in the map, centred around the 
average value in the map. 

Method of Bertin This scale applies two linear scales centred around the 
average value in the map. 

Fifth-order polynomial A fifth-order polynomial is fitted through the sorted values of 
the map using a least squares regression. Class bounds are 
then set to the value of the polynomial at equally sized 
intervals. 

 

Generate labels 

 Click on the „Generate labels‟ button in the legend editor to open the Generate 
labels window – see the image below.  

 Select the desired format from the Format list.  
 Enter the number of decimals with which values should be displayed in the labels.  
 If you want to display a unit in the label, select „Add unit to labels‟ and enter the unit 

in the text box.  
 Press the OK button to update the labels in the legend editor. 
 

 
 

Generate colours 

 Click on the „Generate colours‟ button in the legend editor to open the Generate 
colours dialog window – see the image below. 

 Select an option from the dropdown list just below the Predefined option. The Top 
and Bottom labels indicate how the colours will be arranged in the table. 

 Press the OK button to update the colours in the legend editor. 
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You can also set the colours in the legend according to a custom gradient. The Custom 
part of the Generate colours window allows you to easily make a smooth palette that 
blends from one colour to the next. 
 
 Click on one of the boxes just below the gradient bar to select it. The dropdown list 

under Edit colour will display the colour of the selected box. 
 You can change the colour of the selected box using the dropdown list under Edit 

colour. 
 You can add extra boxes by clicking anywhere on the gradient bar. 
 You can delete an intermediate box by right-clicking on it and selecting Delete from 

the context menu. 
 Press the OK button update the colours in the legend editor. 
 

 
 

Graph 

The graph editor is used extensively in WISE to define two-dimensional relations: time 
series and distance decay functions. The left part of the window displays a graph in 
which you can edit the values by moving, adding or deleting points. The right side of 
the window displays a list of the values in the graph. You cannot edit this list, but it is 
updated as you edit the graph. Values between points in the graph are always linearly 
interpolated. Values before the first point or after the last point are kept constant. 
 

 
 
 You can add points to the graph by double-clicking on a location in the white part of 

the graph. 
 You can remove points by double-clicking on the point you want to remove. 

Graph display area 
Value list 
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 You can move a point by dragging it. You cannot move a point beyond its left or 
right neighbour. 

 You can precisely edit the value of a point by right-clicking on it. This will open a 
dialog where you can enter exact values. 

 You can change the display range of the graph by clicking the Options button. 
 

Single value 

Single values in WISE are displayed in text boxes. Normally, the displayed value is 
rounded. However, when you click on the text box, the exact value will be displayed. 
You can change the value directly in the text box; press the Tab key to commit your 
change. 
 
 Go to Main window → Drivers → Policy Measures → Socio-economic measures. 
 The value for „Rate of change in multi-factor productivity‟ is displayed in a text box 

with two decimals precision. 
 Click inside the text box. The value will be displayed with full precision. 
 Change the value in the text box. Press the Tab key to commit your change. You 

will see that the „Policy measures – Economy sub-scenario‟ will change to 
“(modified)”. 

 Click the „Load sub-scenario‟ button to reload the previous sub-scenario and undo 
your change. 

Time series 

Some time series are displayed as graphs in WISE. Others – for example, time series 
of maps – are displayed as a list of time-value pairs in a table. In this case, you can 
add or remove values for specific times in the time series by clicking the „Add time‟ or 
„Remove time‟ buttons next to the table.  
 
 Go to Main window → Drivers → Parameters → Land use → Land use tab. 
 Click the „Add time‟ button. A window will pop up where you can enter the time you 

want to add to the time series. 
 
Times are displayed and entered in WISE in the format “yyyy-mmm-dd hh:mm:ss”. 
Months are represented by the first three letters of the month‟s name. Note that 
everything after the first part is optional. For example, if you enter “2015” in the „Enter 
date and time” window an click the OK button, the time 2015-Jan-01 00:00:00 will be 
added to the time series. 

Table 

The table editor enables you to enter a series of numerical values. You can select cells 
by clicking or dragging in the table. Click a row or column heading to select an entire 
row or column. Click the top-left header to select the entire table. Press Ctrl+C to copy 
the contents of the table or press Ctrl+V to paste copied values into the table. This way, 
you can easily exchange data between WISE and Excel or a text editor. Note that the 
values are copied as text, so if you copy data from Excel to WISE, you will loose 
precision if the number of displayed decimals in Excel is not set to a high enough 
value. 

Input maps 

Input maps are represented in the user interface by their file name. There is also a 
button that you can click to display the map. You can import a different map by simply 
changing the file name. You may have to reset the simulation for the map to be actually 
loaded and verified in the model. It is also possible to edit input maps in WISE by 
displaying them and using the Grid tools to change the map – see the section Grid 
tools. 
 
 Go to Main window → Drivers → Parameters → Land use → Land use tab. 
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 Click the browse button inside the „Initial land use map‟ box. A dialog will open that 
allows you to select a different file to import. 

 Click the Cancel button in the „Select initial land use map‟ window. 
 Click the „Show / Edit‟ button for the initial land use map. A map window will open 

where you can edit the initial land use map – see the section Grid tools. 
 
The changes you make in a map window will not be stored until you close the map 
window. At that time, you will be asked to save your changes. If you click the Yes 
button, you can select a file name where you want to store the altered map. It is 
important that you do not overwrite any existing files, as it could cause WISE to 
malfunction. When you have selected a new file name, the map will be saved and the 
new file name will be set in the „Initial land use map‟ box. 

2.3 Saving changes 

The previous section Editing Input and displaying output describes how to edit the input 
in WISE. This section describes how to save changes that you made in WISE. 

Saving sub-scenarios 

Sub-scenarios can be defined for each driver in the Main window. The name of the 
active sub-scenario is displayed at the top of the driver – see the image below for an 
example. When you hover the mouse cursor over this name, a description of the sub-
scenario will be displayed as well. The values that are displayed for the driver are the 
values that belong to the active scenario. Whenever you change a value, the name of 
the active sub-scenario will change to “(modified)” to indicate that the currently 
displayed value does not belong to any existing sub-scenario. 
 

 
 

 Go to the zoning driver in the Main window. 

 Change the zoning status for one of the categories. The name of the active sub-
scenario will change to “(modified)”. 

 
You can load an existing sub-scenario by clicking the „Load sub-scenario‟ button. A 
dialog will pop up listing the available sub-scenarios. When you select one and click the 
OK button, the values for the driver will be updated. 
 
You can save the changes you have made to a driver in a new sub-scenario by clicking 
the „Save sub-scenario‟ button. Provide a name and description in the dialog that will 
pop up and click the OK button. You will see that the name of the active sub-scenario 
will change to the name you just entered. 

Active sub-scenario 
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Integrated scenarios 

Sub-scenarios can be defined for each driver in the Main window. The combination of 
one sub-scenario for each driver is called an integrated scenario. The active integrated 
scenario is always displayed in the toolbar. Here you can also load a different 
integrated scenario by selecting it from the dropdown list. When you do this, the 
according sub-scenarios will be loaded for each driver. 
 
As is explained in the previous section, you can change the active sub-scenario for a 
driver in the Main window by clicking the „Load sub-scenario‟ or „Save sub-scenario‟ 
button. When you do this, the active integrated scenario displayed in the toolbar will be 
updated automatically. If an integrated scenario already exists for the set of active sub-
scenarios, it will be selected. Otherwise, the active integrated scenario will be displayed 
as “(modified)”. Also, when you change the value of a driver, the active integrated 
scenario will change to “(modified)” just like the active sub-scenario for the driver you 
have changed. 
 
You can create new integrated scenarios by going to the „Scenario manager‟ page in 
the Main window (under the Scenario tab). Click the New button and enter the 
requested information in the dialog that will pop up. Note that the new integrated 
scenario will not be activated automatically. To do so, select it from the „Integrated 
scenario‟ list. You can also load sub-scenarios on this page; the effect will be the same 
as loading them on the page for the respective driver. 
 
You can delete the active integrated scenario by clicking the Delete button on the 
„Scenario manager‟ page in the Main window. This will not affect which sub-scenarios 
are loaded for each driver. Hence, the active integrated scenario will change to 
“(modified)”, as no integrated scenario exists anymore for the current set of active sub-
scenarios. You can define a new integrated scenario by clicking the New button or by 
saving the project (see section Saving a project). 

Managing sub-scenarios 

You can get an overview of all the available sub-scenarios and which integrated 
scenarios they are used in by clicking the „Manage sub-scenarios‟ button on the 
„Scenario manager‟ page in the Main window (under the Scenario tab). This will open a 
dialog similar to the one depicted below. 
 

 
 

 Select one of the drivers from the list. The Sub-scenario list will be updated with 
the sub-scenarios that are available for the selected driver. 

 Select a sub-scenario from the list to view its description. The Description and 
the list of „Integrated scenarios that use this sub-scenario‟ will be updated. 

 Click the Rename button to rename a sub-scenario. Your change will not be 
committed until you click the OK button. 

 Click the Delete button to delete a sub-scenario. You cannot delete a sub-
scenario that is used in one or more integrated scenarios. You will first have to 
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remove these integrated scenarios. The sub-scenario will not be deleted until 
you click the OK button. 

Saving a project 

Click the Save button on the toolbar or select „Save project‟ from the File menu in order 
to save all the changes you have made thus far in the opened project. When you save 
a project, you have to save any changes you made to a driver (or discard the changes) 
and save the set of active sub-scenarios in an integrated scenario. Any changes made 
to other parameters (accessible from the Parameters page in the Main window) are 
also saved. You cannot discard these changes and you cannot create scenarios for 
them. 
 

 Re-open the Waikato project. Discard any changes you made to an open 
project. 

 Go to Main window → Drivers → Policy measures → Zoning. Click on the 
„Category precedence‟ tab. 

 Change the zoning status for one of the categories in the table. The active sub-
scenario will change to “(modified)”. 

 Click the Save button on the toolbar. The „Save project‟ dialog will pop up. It 
looks similar to the image depicted below. 

 

 
 
The top part of this dialog provides settings for each driver. If a driver has not been 
changed since the last time it was saved, the (disabled) list will show “(No changes)”. 
Otherwise, the list will provide the option to discard the changes or to save them in the 
active or a new sub-scenario. By default, the settings in the „Save project‟ window will 
be set to overwrite the last active sub-scenario (i.e. the one that was active before you 
made changes), unless that sub-scenario is read-only. 
 

 Select the option „Save as new sub-scenario‟ for the zoning driver. Note that the 
„Save as active integrated scenario‟ option will become disabled. This prevents 
you from accidentally overwriting an integrated scenario. 

 Click the More button to enter a name and description for the new sub-scenario. 

 Enter the integrated scenario name and update the description. 

 Click the Save button to save the project. 

 

Exporting a project 

When you save a project – as explained in the section Saving a project – you overwrite 

the project file. This is no problem for the drivers, since you can save different values in 
different sub-scenarios. But for all the other parameters (accessible from the 
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Parameters page in the Main window), you can only save one value in a project. 
Therefore, to save different values for these drivers (e.g. while calibrating) you need to 
save different project files. This is possible when you select „Save project as‟ from the 
File menu to save the project. However, caution is advised when using this option, 
because different project files will share the same data stored in external files (e.g. 
maps). A good guideline to follow in this situation is to always reset the simulation 
before saving the project. 
 
WISE also provides the option to save a project together with all required external data 
files (e.g. maps). This option is convenient when you want to copy your project to a 
different computer. 
 

 Select „Export project‟ from the File menu. 

 
If you have made any changes since the last save, the „Save project‟ dialog will pop up 
asking you to save your changes. This works the same as explained in the section 
Saving a project, only when you click the Save button, your project will not be saved 
immediately, but first the „Export project‟ dialog will pop up. If you did not make any 
changes, the „Export project‟ dialog will pop up immediately when you export a project. 
It looks similar to the image depicted below. 
 

 
 
The table on the dialog lists the file names of all external data files that are used by the 
project. Each file name can be changed individually or you can copy-paste the last 
column to a text editor or Excel to easily change all the files. 
 

 Select the last column in the table by clicking on the „File name‟ column header. 

 Copy the contents of the last column by pressing Ctrl+C on the keyboard. 

 Paste the copied text to a new Excel workbook (or your preferred text editor). 

 Select Replace from the Edit menu and replace the folder of the project file with 
a different folder – e.g. you can replace “C:\...\WISE\” with “C:\...\WISE copy\”. 
Click the „Replace All‟ button. 

 Copy the changed text from Excel (Ctrl+C). 

 Click on the „File name‟ column header in the „Export project‟ window. 

 Press Ctrl+V to paste the changed file names into the table. 

 Check that all the file names in the table now refer to the same folder. 

 Change the „Project file‟ to the correct folder. 

 Change the „Legend file folder‟ to be a subfolder of the folder where you will 
save the project file. All the files in the legend folder will be copied. 

 Click the Save button to export the project. 
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2.4 Running a scenario 

Once the Main window and the Land use map window have been opened, the program 
has read the default values for all the parameters as well as the initial values for all the 
state variables of models. The program is ready to run a scenario. You can run a 
scenario with the control buttons on the toolbar or with the commands on the 
Simulation menu. 
 

 
 
On the toolbar as depicted in the figure above, the left-most box displays the active 
integrated scenario. The right-most box displays the Simulation clock, which indicates 
the current simulation time. The initial year is 2006 in WISE. 

Active integrated scenario 

Before you start running the simulation, check which integrated scenario is active. This 
determines which scenario will be calculated. 
 
 Expand the „Integrated scenario‟ dropdown list on the toolbar by clicking on the 

downward arrow. The available integrated scenarios will be displayed on the list. 
 Select an integrated scenario from the list, for example, the Baseline integrated 

scenario. 
 

 When collapsed, the list box shows the name of the active integrated scenario. 
When you select a different integrated scenario, it will be loaded and become the 
active integrated scenario. However, if the previously active integrated scenario 
was “(modified)”, a message box will pop asking if you want to save your changes. 
If you click the No button, your changes will be discarded and the selected 
integrated scenario will be loaded. If you click the Yes button, the project will be 
saved as if you pressed the Save button on the toolbar – see the section Saving a 
project. Afterwards the selected integrated scenario will be loaded. 

 
Note that loading an integrated scenario means loading the associated input data and 
parameter values to the user interface. The results that are calculated by the model are 
not updated for the newly loaded scenario immediately. You can use the Update, Step, 
Run and Reset commands to calculate the models. 

Reset 

You can reset the simulation clock to the start year of the simulation by clicking the 
Reset button on the toolbar or by clicking Reset on the Simulation menu. While the 
model is calculating, a progress bar will be displayed in the status bar. The progress 
bar will disappear when the calculations are finished. 
 
Whenever you change initial values or initial maps in WISE, you need to reset to 
complete the changes. 

Update 

Click Update on the Simulation menu to recomputed the model without changing the 
current simulation time. Changes to initial values, parameters that do not affect the 
current simulation time or time-dependent variables in the model (such as the land use 
map) will not be recalculated when you update the simulation. For this reason, updating 
a simulation is mostly much quicker that resetting or running the simulation. While the 
model is calculating, a progress bar will be displayed in the status bar. The progress 
bar will disappear when the calculations are finished. 

Active integrated scenario Simulation clock 
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Step 

Click Step on the Simulation menu or click the Step button on the toolbar to advance 
the simulation clock by one time-step (mostly one year). This option is useful to view 
the effect of the changes you have made on time-dependent variables calculated by 
the model. While the model is calculating, a progress bar will be displayed in the status 
bar. The progress bar will disappear when the calculations are finished. 

Run 

Click Run on the Simulation menu or click the Run button on the toolbar to 
progressively advance the simulation clock till the end of the simulation period (or the 
next simulation pause). The simulation clock and the displayed results will be updated 
after each time-step of the model. While the model is calculating, a progress bar will be 
displayed in the status bar. The progress bar will disappear when the calculations are 
finished. 

Stop 

Click Stop on the Simulation menu or click the Stop button on the toolbar while running 
a simulation to stop the simulation. The simulation may not stop immediately, because 
the calculations for the current simulation step are completed first in order to avoid 
corrupting the system. Some functions in the user interface require you to stop the 
simulation first. In this case, click the Stop button on the toolbar and wait till the 
calculations are completed – the progress bar in the status bar will disappear. 

2.5 Saving results 

Write to Excel 

Click „Write to Excel‟ on the Options menu to open or close a link between WISE and a 
Microsoft Excel workbook. The window that will appear, will display a list of model 
blocks that allow their results to be written to Excel. Enter a unique sheet name for 
each model block that you want to write to Excel – you can copy-paste the model block 
names. Then enter a list of simulation times at which the model results should be 
written. When you click the „Start writing‟ button, a new Excel workbook is opened in 
the background and the model results will be written as you run the simulation. While 
the link between WISE and the Excel workbook is open, you can see that „Write to 
Excel‟ on the Options menu is checked. Come back to the „Write to Excel settings‟ 
window and click the „Open Excel workbook‟ button to stop writing to Excel and display 
the created workbook. 
 

 Click „Write to Excel‟ on the Options menu. The „Write to Excel settings‟ window 
will appear. 

 Select all of the model block names and press Ctrl+C to copy the names. 

 Select the cell just below the „Excel sheet name‟ column heading and press 
Ctrl+V to paste the copied names. The values in the „Excel sheet name‟ column 
should now match the values in the „Model block name‟ column. 

 Click the Generate button. The „Generate moments‟ window will appear. The 
default settings in this window will generate a list of moments for each year of 
the simulation period. 

 Click the OK button. The list of Writing moments in the „Write to Excel settings‟ 
window will be filled. 

 Click the „Start writing‟ button. WISE will open a new Excel workbook in the 
background. 

 Take one or more simulation steps by clicking the Step button on the toolbar. 

 Click „Write to Excel‟ on the Options menu again. 

 Click the „Open Excel workbook‟ button. The Excel workbook that WISE has 
written the model results to will open. 
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Model results are written to Excel in a format that is suitable for making pivot tables. 
This way you can easily arrange the values in Excel in the way you want to present 
them. 
 

 Select the Population sheet in the open Excel workbook. 

 Click „PivotTable and PivotChart report‟ on the Data menu. A wizard will appear 
where you can configure a PivotTable or PivotChart. 

 Select the option „PivotChart report‟ in the wizard and click the Finish button. A 
PivotTable and PivotChart will be created in new sheets. 

 Drag items from the „PivotTable Field List‟ window onto the chart to configure 
the graph the way you want. For more information advice the Excel help 
function. 

 

 

Log maps 

Click „Log maps‟ on the Options menu to save maps that are calculated by WISE to 
disk for further analysis. The logged maps are automatically added to a log file that can 
be opened with the Map Comparison Kit – see the section Map comparison. The maps 
themselves are saved in subfolders of the log file. You can store the maps for different 
simulation runs in different subfolders. This way you can easily log the maps for 
different scenarios and then compare the scenario results in the Map Comparison Kit. 
Note that network maps can be logged, but are not added to the MCK log file and 
cannot be displayed in the MCK. 
 

 Make sure the Baseline integrated scenario is active by selecting it from the 
„Integrated scenario‟ list on the toolbar. 

 Click „Log maps‟ on the Options menu. The „Log settings‟ window will appear. 

 In the „Maps to log‟, select the land use map (Entire model → Land use model 
→ Land use → Land use map). 

 Change the „MCK log file‟ if you want to store the maps in a different folder. 

 Enter a „Simulation name‟ that is equal to the active integrated scenario 
(Baseline). 

 Click the Generate button and change the settings to generate log moments for: 
2010, 2020, 2030, 2040 and 2050. 
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 Click the OK button in the „Generate log moments‟ window. The „Log moments‟ 
list should now contain the values: 2006, 2010, 2020, 2030, 2040 and 2050. 

 Make sure the „Turn logging off after last log moment‟ option is selected. If it is 
not, you risk overwriting previously logged maps. By automatically turning off 
the logging at the end of a simulation run, you will have to manually turn it back 
on when you run e.g. a different integrated scenario. At that time, all you need 
to change in the „Log settings‟ window is the „Simulation name‟. By choosing a 
unique name, you will prevent overwriting previously logged maps. 

 Click the „Turn logging on‟ button. „Log maps‟ on the Options menu will now be 
checked to indicate that maps will be logged when you run a simulation. 

 Click the Reset button on the toolbar. When the simulation is reset, click the 
Run button to run the simulation till the end year. 

 Go to Main window → Analysis → Map Comparison. 

 Click the „Start MCK‟ button. The Map Comparison Kit will open with the log file 
that you selected before in the „Log settings‟ window. In the MCK you can 
compare the different maps that have been logged. See the MCK user manual 
for more information. 

Animate maps 

Click „Animate maps‟ on the Options menu to create animated images of maps that are 
calculated by WISE for use in a presentation or on a website. Animations are stored as 
animated GIF files. Each simulation step will be one frame in the file. 
 

 Click „Animate maps‟ on the Options menu. The „Animation settings‟ window will 
appear. 

 In the „Maps to animate, select the land use map (Entire model → Land use 
model → Land use → Land use map). 

 Change the animation folder if you want to save the animated GIF files in a 
different folder. For example, you can use the name of the active integrated 
scenario as the last subfolder. 

 Under „Animation size‟, select the option „Screen (800 x 600)‟ if you want to 
generate an animation for a presentation or website. Select the option „Actual 
size‟ if you want to assure that each pixel in the land use map corresponds to 
one pixel in the animated image. 

 
Note that the exact size of the generated images can differ from the selected size, 
because the aspect ratio of a map is preserved. The selected option will limit the 
maximum size of the image, so if you selected „Screen (800 x 600)‟ the generated 
image will be no wider than 800 pixels and no higher than 600 pixels. 
 

 Click the OK button in the „Animation settings‟ window. „Animate maps‟ on the 
Options menu will now be checked to indicate that maps are animated when 
you run a simulation. 

 Click the Reset button on the toolbar. When the simulation is reset, click the 
Run button to run the simulation till the end year. 

 The animated GIF files are stored in the folder you have selected. You can view 
them with any descent browser or image viewer. Note that the simulation time is 
printed in the top-left corner of the image. 

 To turn map animations off, click „Animate maps‟ on the Options menu again. 
Then deselect all „Maps to animate‟ and click the OK button. You will see that 
„Animate maps‟ on the Options menu is no longer checked. 
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2.6 Tools for analysing results 

Monte Carlo tool 

The „Monte Carlo‟ page in the Main window (under the Analysis tab) allows you to run a 
simulation repeatedly for a specified number of times. The stochastic nature of the land 
use model will yield slightly different results for each simulation run. The Monte Carlo 
tool counts the frequency of occurrence of each land use class in the land use map at 
the end of the simulation period. It also provides the ability to combine and display this 
information comprehensibly in a composed probability map. However, before you can 
display these maps, you will need to perform a Monte Carlo run or import the results of 
a Monte Carlo run from another computer – see below. 
 

 
 
To perform a Monte Carlo run, click the „Start Monte Carlo run‟ button and enter the 
settings in the dialog that pops up – see the figure below. For the name, you‟ll probably 
want to use the name of the active integrated scenario. The results folder will be used 
to store the probability map for each land use. Make sure this is an empty folder. 
 

 
 
While the Monte Carlo run is being performed, you can view the progress in the Main 
window. When the run is completed, the results will be saved to disk and the run will be 
added to the „Available Monte Carlo runs‟ in the results section. Save the project (see 
the section Saving a project) in order to store the entries in this list. Otherwise, you can 
still import the saved results by clicking the Import button. 
 
To copy the results of a Monte Carlo run to another computer, select the Monte Carlo 
run in the „Available Monte Carlo runs‟ list and click the „View files‟ button. This will 
open a new window displaying the contents of the folder in which the results have been 
saved. Copy all the files in this folder to another computer and, on that computer, click 
the Import button to import the copied files. 
 
After you have performed or imported a Monte Carlo run, you can view the probability 
map for each land use class by clicking the „Show probability map‟ button. This will 
open a dialog similar to the one depicted below. Select the Monte Carlo run and the 
land use for which you want to display the map and click the OK button. The map will 
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display values between 0 and 1 that indicate the fraction of simulation runs in which the 
selected land use occurred in the land use map at the end of the simulation period. 
 

 
 
It is also possible to display more comprehensive maps, in which the probability map 
for different land uses can be combined with information from the initial land use map. 
These are called composed probability maps in the system. You can create one by 
clicking the Add button next to the list of composed probability maps in the Monte Carlo 
tool. This will open a dialog similar to the one depicted below. 
 

 
 
Click the Add button in this dialog to add a column in the „Combined probabilities‟ table. 
Each column represents the probability that one of the land uses selected in that 
column occurs in the simulated land use map. For example, to define the probability of 
urbanisation, select all the urban land uses. 
 
You can list the categories that will be displayed in the composed map in the Rules 
table. Each row in this table represents one category in the composed map. The rules 
are evaluated from top to bottom and the first rule that applies determines the value in 
the composed map. If no rules apply, the value in the composed map will be „no data‟. 
The first column in the Rules table specifies the name of each rule. The second column 
specifies a selection of land use classes for each rule. The rule only applies if the initial 
land use is one of the selected classes. The third and subsequent columns match the 
columns in the „Combined probabilities‟ table. These columns specify a boundary 
condition within which each rule applies. For example, in the dialog depicted above, the 
rule „High probability of urbanisation‟ only applies in those cells that have a probability 
of urbanisation larger than 0.75. Note that this rule does not apply to locations with an 
urban land use in the initial land use map, as these location will be categorized as 
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„Existing urban‟, which is listed above the „High probability of urbanisation‟ rule in the 
Rules table. 
 
The order in which the rules need to be defined thus depends on how they should be 
interpreted, i.e. which rules should take precedence over which other rules. This order 
may not be the most suitable order to list the categories of the composed map in its 
legend. Therefore, you can change the order of the legend categories in the Legend 
table by selecting one or more categories and clicking the „Move up‟ or „Move down‟ 
buttons. 
 
You can view any composed probability map you have defined for any Monte Carlo run 
that you have performed or imported. For example, you can create “Probability of 
urbanisation” maps for the baseline scenario as well as an alternative scenario. To 
view the maps, click the „Show probability map‟ button in the Monte Carlo tool. Select 
the desired Monte Carlo run and composed probability map and click the OK button. 
An example of the “Probability of urbanisation” map that we defined above is depicted 
below. 
 

 
 

Map comparison 

The Map Comparison Kit (MCK) is a stand alone software tool that includes a number 
of algorithms that you can use to analyse your results. WISE can open the MCK to 
analyse results as follows:  
 Go to Main window → Analysis → Map Comparison. 
 Click the „Start MCK‟ button in the content pane of the Main window. If you do not 

have the MCK installed on you computer. You can click the link to download it for 
free. 
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The MCK comes with its own dedicated manual which is delivered as an integral part of 
the WISE package. It explains the use of the MCK and describes in detail how you can 
analyse and compare logged maps generated by WISE in an interactive manner. All 
logged maps generated by WISE can be read in the MCK in a straightforward manner. 
 
An example of how to use the Map Comparison Kit to compare scenarios is given in 
the section Analysing results. 
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3. Policy interface 
The user interface of WISE provides access for two types of users: policy users who 
carry out impact assessment studies related to the impact of certain policies under a 
range of external conditions and the modeller, who is responsible for the underlying 
(scientific) information of the system and needs to adapt underlying data and 
parameters when more information becomes available over time. 
 
The Main window of WISE provides access for both types of users. The structure of the 
Main window is available in the section Main Window. This chapter explains how the 
policy user can use the system and the next chapter explains how the modeller can 
access the models.  
 
The policy user finds access to all policy-relevant information in the Main window. This 
information is organised in such a way that the user can carry out a structured analysis. 
It follows the steps Drivers, Scenarios, Indicators and Analysis, each of which is 
explained in more detail below.  

3.1 Overview of the policy interface 

This section gives a brief overview of the steps you can take to carry out a policy 
impact assessment with WISE. In the following sections each step will be explained in 
detail.  
 
When clicking on the Drivers tab in the Main window you get access to the different 
types of drivers: External factors, Policy measures and Parameters. The first two are 
part of the policy interface of the system; the last provides access to the details of the 
underlying models for scientists or modellers. Clicking on each of the icons opens the 
settings for this driver or set of drivers in the content pane on the right. 

Step 1: Setting up the drivers 

Drivers incorporated in the system are organised in two groups: External factors and 
Policy measures. When you click on one of these, you get access to the underlying 
information. This is also the entry point for adapting drivers and entering new data. 
 
The result of this step is a set of sub-scenarios for each of the drivers. When 
developing a sub-scenario you can build on existing sub-scenarios. For example, you 
can load the baseline sub-scenario, change it and then save the changes as a new 
sub-scenario. Then you can load the baseline scenario again and made different 
changes. 
 
Drivers for policy user that are included in WISE are the following:  

 External factors 
- Economy: international exports, interregional exports, gross fixed capital 

formation 
- Population: fertility lever, mortality lever, additional net in-migration for each 

district 
 

 Policy measures 
- Economy: rates of change in eco-efficiency, rates of change in multi-factor 

productivity 
- Population: proportion of people living in each residential land use category for 

each district 
- Zoning measures 
- Infrastructure 

 
The steps required to view or change driver settings are described in the section 
Setting up the drivers. 
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Step 2: Creating integrated scenarios 

In the second step, integrated scenarios can be assembled from a selection of existing 
sub-scenarios. For each of the drivers you need to select one sub-scenario. 
 
The steps required to create integrated scenarios are described in the section 
Integrated scenarios. 

Step 3: Running the simulation 

In order to investigate the impact of certain scenarios, you need to run the simulation 
for each integrated scenario of interest. While you run simulations, there are several 
ways to export intermediate and final results of the model for later use in step 5. 

 You can log maps which can be analysed afterwards in the Map Comparison Kit 
(part of the WISE package) or GIS packages – see the section Log maps. 

 You can make an animation of a map that shows how the map changes over time – 

see the section Animate maps. You can open the animation in a viewer, but can 
also incorporate them in presentations or on a website. 

 You can create a link to Excel through which all selected model results are directly 
written to Excel – see the section Write to Excel. This can be used for analyses and 

post-processing afterwards. 
 
Before running the simulation you can decide which results you would like to save to 
disk. For details about running the simulation and saving results, please refer to the 
section Running a scenario and the section Saving results. 

Step 4: Visualising indicators 

After a simulation is finished, WISE offers several options to analyse results. The first 
option is to visualise indicators. The indicators are organised in four groups: 

 Social indicators 

 Economic indicators 

 Environmental indicators 

 Land use indicators 
 
Each of these indicators is calculated on a yearly basis. Depending on the type of 
indicator, it is calculated at one or more spatial levels (regional, district and local). You 
gain access to the indicators by clicking the Indicators tab in the Main window. Steps to 
take in visualising indicators are described in the section Visualising indicators. 

Step 5: Analysing results 

The final step of an impact assessment study is to analyse results within an integrated 
scenario (e.g. the temporal evolution of an indicator) or to compare a set of integrated 
scenarios. In step 3 of the assessment you have selected which information you want 
to save for analysis. In this step you carry out the analysis thereof. Excel files that have 
been created can be analysed with Excel; animations can be shown in a viewer; and 
logged maps that have been saved in log-files that can be compared in the Map 
Comparison Kit, which is accessible from the Analysis tab in the Main Window.  

3.2 Setting up the drivers 

In this section you will become familiar with the different drivers in the system and learn 
how to enter and change information related to these drivers. There are 3 sections 
under the Drivers tab: External factors, Policy measures and Parameters. Among them, 
the Parameters section is relevant only to a modeller. The detailed description about 
the Parameters section will be found in the section Modeller interface. 

External factors 

For true integration of different disciplines, WISE incorporates not only the economic 
model, but also models related to climate change, hydrology, water quality, 
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demography, land use and terrestrial biodiversity. In the economic model, some 
parameters are external factors and some are policy measures. The external factors 
are accessible on the „External factors‟ page in the Main windows (under the Drivers 
tab). 
 

 
 
When you have the External factors in front of you, you can carry out the following 
actions: 

 View historic data and projections 

 Adapt historic data and projections 

 Load an existing sub-scenario 

 Make changes to an existing sub-scenario and save it as a new sub-scenario 
 
Since the steps are very similar for all external factors we take Population as an 
example to explain how you can work with the external factors. 

How to view data and projections for the Baseline sub-scenario? 

 Go to the Drivers tab in the Main window. 
 Click the External factors icon. 
 If the Population sub-scenario is not set to Baseline, click the „Load sub-scenario‟ 

button and load the Baseline sub-scenario. 
 Click the Fertility lever button. The „Fertility lever‟ graph window will open. 
 
This graph shows the fertility lever as a percentage on the vertical axis and the year on 
the horizontal axis. You can click the Cancel button to go back to the Main window.  
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How to adapt values for external factors? 

 Go to the Drivers tab of the Main window. 
 Click the External factors icon.  
 Click the Fertility lever button. The „Fertility lever‟ graph window will open. 
 
There are several ways to enter new population figures in the system. The first way is 
to drag the bubbles in the graph to the desired value. You can also enter the precise 
values by right-clicking on a bubble. More bubbles can be added to the graph by 
double clicking with the mouse in the graph and bubbles can be removed by double 
clicking with the left mouse button on a bubble.  
 Remove all points (bubbles) for which you do not want to provide scenario 

information. 
 Add a point for years you would like to provide scenario information for. 
 Right-click the bubbles to enter the exact values for the year and the fertility lever.  
 Press the OK button to save your results and close the graph. 
 
You have now adapted the population scenario in the external factors section. The 
active sub-scenario at the top of the driver reflects this by showing the name 
“(modified)”. You can create a new sub-scenario with the values you just entered by 
clicking the „Save sub-scenario‟ button. 
 

 Click the „Save sub-scenario‟ button. The „Save external factors – Population 
sub-scenario‟ window will pop up. 

 Enter the name “Test population” (without quotes) after the „Save in new sub-
scenario‟ option. 

 Enter a description and click the OK button. 

 
You have now created a new sub-scenario Test_population for the external factors - 
population scenario. 
 

Policy measures – socio-economic measures 

Besides external factors, WISE also incorporates socio-economic policy measures. 
These measures can be found by clicking on the Policy Measures icon under the 
Drivers tab in the Main window and selecting „Socio-economic measures‟ from the 
Driver list. 
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How to adapt values of economic measures? 

 Go to the Drivers tab in the Main window and click the Policy measures icon. 
 Select the Socio-economic measures from the Driver list. 
 Select the economic sector of your interest from the „Rates of change in eco-

efficiency in sector‟ list. 
 Enter a new value in the text box to the right. 
 Press the Tab key on your keyboard. 
 
You have now changed the value of the rates of change coefficient for a certain sector. 
You will see that the active sub-scenario has changed to “(modified)”. Click the „Save 
sub-scenario‟ button to save your changes as a new sub-scenario or click the „Load 
sub-scenario‟ button to load an existing sub-scenario and discard your changes. 

How to adapt values of population measures? 

 Go to the Drivers tab of the Main window and click the Policy measures icon in the 
navigation pane. 

 Select the Socio-economic measures from the Driver list. 
 Select the district of your interest from the District list.  
 
The proportion of people living in each residential land use category for the selected 
districted are displayed in the table. The value in the last row is automatically updated 
to make the column total 100%. If the values for residential classes sum to more than 
100%, the values in that column are highlighted with red background. These values are 
invalid and will not be transferred to the model until a valid set of values is entered. 
 
The values for the start year of the simulation are given and cannot be changed. Some 
columns are empty, meaning the values in that year will be determined from a linear 
interpolation of the previous and next defined values. After the last year for which 
values are specified, the values will be kept constant. 
 Double the proportion of people living in “Residential – Medium to High Density” by 

2015. You will see that the proportion of people living in non-residential land uses is 
updated automatically. 

 You can reset a value to its linearly interpolated value by selecting the cell in the 
table and pressing the Delete key on your keyboard. 

 
You have now changed the policy measure for population. The active sub-scenario will 
be displayed as “(modified)”. Click the „Save sub-scenario‟ button to save your changes 
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as a new sub-scenario or click the „Load sub-scenario‟ button to load an existing sub-
scenario and discard your changes. 

Policy measures – Zoning 

Zoning maps represent the policy part of the land use change model. Different 
locations have different restrictions for particular land uses. For any particular area, the 
development of one set of land uses can be allowed, while the development of another 
set of land uses can be prohibited. For this reason there is a specific zoning map for 
each main land use function incorporated in the system: residential (lifestyle blocks, 
low density and medium to high density), commercial, community services, horticulture, 
biofuel cropping, vegetable cropping, other cropping, dairy farming, sheep, beef or deer 
farming, other agriculture, forestry and manufacturing. The vacant land uses do not 
have a specific zoning map since we assume that this type of land use is allowed 
everywhere, but that there are no areas where it is specifically planned. In general, 
vacant land uses are the land uses that appear when (agricultural) land is abandoned 
and also the land use that can easily be taken over when socio-economic functions 
expand.   

Zoning tool 

The Zoning tool in WISE allows you to incorporate your spatial planning in the land use 
change model. You can enter spatial plans in the zoning tool and interpret their 
meaning for different land use classes in a comprehensible way. Plans can be ordered 
hierarchically, such that one overrules the other in case of conflict. When more 
information or new zoning plans become available, this can be incorporated in the 
zoning tool, either by the project team, or by the users themselves.  
 
Before we will start to use the zoning tool, let‟s go over the most important terminology 
that will be used in the explanation. 
 
Plan – A plan is a map that represents any spatial zoning plan. It contains source data 
which is not interpreted in terms of its effect on land use yet. A plan can contain one or 
more categories, such as “protected forests”, “flood prone areas” or “residential”. Any 
number of plans can be entered in the zoning tool, for example, the spatial plans of 
each district as well as regional plans can all be incorporated as separate zoning plans. 
 
Category – A plan can have one or more categories, each of which is represented by a 
category in the map. For example, a plan that outlines the protected areas can have 
the categories protected forests, protected natural area and non-protected nature. No 
data values in the map will not be interpreted in the zoning tool – that is, they cannot be 
assigned a zoning status. 
 
Zoning status – Each category in a plan needs to be interpreted in terms of their zoning 
status for each land use function separately. The following zoning statuses are 
available in WISE: Permitted, Controlled, Restricted discretionary, Discretionary, Non-
complying, Prohibited and Actively stimulated (see the specification report for more 
information). Moreover, a category can be interpreted as ”unspecified”, meaning that 
the specific category does not influence a specific land use function or that no 
information for that category is available. 
 
Start time / End time – A category in a plan can start and stop at any given time in the 
simulation. By default a plan is valid from the start year of the simulation until the end 
year of the simulation. However the start year, the end year or both can be set per 
category. This time setting per category is assumed to be equal for all land use 
functions. 
 
Zoning map – The zoning map is the result of the interpretation and combination of all 
categories in all spatial plans. It indicates the zoning status in each cell for a particular 
time span. Zoning maps are specific for each land use function and have a timestamp, 
since zoning regulations can change over time. 
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Because multiple zoning plans can be introduced in the zoning tool, it is possible that 
two plans will provide conflicting zoning information – e.g. according to one plan 
residential development is allowed, whereas it is prohibited in another plan. To resolve 
such conflicts, the set of all categories in all zoning plans is ordered hierarchically in the 
zoning tool. Higher ordered categories overrule lower ordered categories. This 
hierarchy among categories is assumed to be the same for all land use functions. 

Importing or editing zoning plans 

Zoning plans are represented as raster maps with categorical data. You can import a 
new zoning plan, if the map that represents that plan fulfils the following criteria: 

   The projection, extents and cell size of the raster map match those of the land 
use map. 

 The values in the map are subsequent integers starting from 0 (first category) 
up to but excluding the number the number of categories. A maximum of 250 
categories per zoning plan is allowed. 

 The „no data‟ value in the map should be set to 255. 
Maps can be preprocessed in a GIS to fulfil these criteria. 
 
To import a new zoning plan: 

 Go to Main window → Drivers → Zoning → Plans and categories. 

 Click the „Import plan‟ button. 

 Enter a Name. 

 Click the browse button inside the Map box to open the zoning plan to import. 

 Select an existing legend or create a new one. Click the „Edit legend‟ button to 
preview or change the legend – see the section Legend editor. 

 Click the OK button. The zoning plan will be added to the list in the „Plans and 
categories‟ tab of the zoning tool. The categories in the zoning plan will be 
added to the bottom of the table on the „Category precedence‟ tab. The default 
settings of these categories will be such that they have no influence on the 
zoning maps that are calculated by the system. If you later change the legend 
of the zoning plan, the settings for these categories will be reset to their 
defaults, so make sure the legend you enter is correct before you click the OK 
button. 

 You can view the imported zoning plan by selecting it on the „Plans and 
categories‟ tab and clicking the Show button. 

 

 
 
To edit an existing zoning plan: 

 Go to Main window → Drivers → Zoning → Plans and categories. 

 Select the zoning plan you would like to edit. 

 Click the „Edit‟ button. Change the settings in the window that pops up and click 
the OK button to confirm. The information in the zoning tool will be updated. If 
you have changed the legend of the zoning plan or if you have selected a 
different legend, the settings on the „Category precedence‟ tab of the zoning 
tool will be reset to the default values for the categories on the edited zoning 
plan. You will find the categories at the bottom of the table. 
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Interpreting zoning plans 

After you have imported all zoning plans, you can interpret them to indicate the effect 
for each land use function. On the „Category precedence‟ tab of the zoning tool, the 
interpretation of all zoning plans is displayed in a table. The order of the categories in 
the table indicates the precedence; categories at the top overrule lower-placed 
categories. You can change the order by selecting a category (i.e. a row in the table) 
and clicking the buttons to the left of the table. The order is the same for all land use 
functions. 
 
The start and end time of each category can be set in the last two columns. These 
settings are the same for all land use functions. Double-click the browser button ( ) 
inside the cell to change the start or end time. The displayed icons indicate the start of 
the simulation period ( ) or the end of the simulation period ( ). When the start time 
of a category is set to 1-1-2010, that category will not influence the land use change 
model before that date. This means that the category first has an effect on zoning on 
the first day of 2010, which is only considered in the land use allocation on the first day 
of 2011. The end time indicates the simulation time from which a category no longer 
has an influence. If this is set to 1-1-2020, the category will not influence zoning on the 
first day of 2020, which is used for the land use allocation on the first day of 2021. But 
the category will still have an influence on zoning on the first day of 2019, which is used 
for the land use allocation on the first day of 2020. 
 
In contrast to the other settings, the zoning status of a category is specified for each 
land use function individually. You can view or change the zoning status for a particular 
land use by selecting it from the „Land use type‟ list above the table. You can change 
the zoning status of a category by double-clicking in the table and selecting a different 
zoning status from the dropdown list. When the zoning status is set to “Unspecified”, 
the category will not be considered in calculating the zoning map for the selected land 
use function. 

Viewing zoning maps 

You can view how all the settings in the zoning tool are combined into a zoning map for 
each land use by clicking the „Preview zoning map‟ button on the „Category 
precedence‟ tab in the zoning tool. This will open a map window that displays the 
zoning map for the selected land use. In the layer manager pane on the top-right of the 
opened map window, you can see a list of times. These are the simulation times at 
which the zoning map for the selected land use will change. Click on a time to display 
that zoning map. 
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You can change the settings on the „Category precedence‟ tab in the zoning tool while 
the „Preview zoning map‟ window is open. The map will be updated interactively as you 
make changes to the settings. This way you can immediately observe the influence of 
your changes on the zoning map. Note though that the system needs to recalculate the 
zoning map after every change you make in the „Category precedence‟ tab, so the 
system may become somewhat slower to respond. You can close the „Preview zoning 
map‟ window at any time and open it again later. 
 
It is not possible to preview zoning maps for multiple land uses at the same time. As 
soon as you change the selected „Land use type‟ in the „Category precedence‟ tab, the 
„Preview zoning map‟ window will be closed automatically. 
 
For more information about working with a map window, see the section Map window. 

Policy measures – Infrastructure 

The relationship between land use and transport systems is generally recognized, by 
planning professionals as well as scientists. Also, and importantly, it is recognized that 
the relationship is reciprocal, which means that developments in land use are in part a 
consequence of the transport system and, at the same time, developments in the 
transport system are by large the effect of land use changes.  
 
The current version of WISE only incorporates a one-way influence of transport on land 
use. In future versions a transport model could be incorporated with which the impact 
of land use on transport can also be simulated. Currently, the transport network (roads 
and railways) is incorporated in the infrastructure driver. Other infrastructure layers 
incorporated in WISE are: Major processing sites and Residential attractants. 
 
Land use is influence by the infrastructure driver through accessibility, which is a 
function of the distance to different types of infrastructure elements (e.g. local roads or 
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highways). Policy decisions that influence accessibility are mainly the construction of 
roads, railways or processing sites. In this exercise you will learn how to adapt the road 
network. 
 

 
 
The figure above shows the policy user interface for the Infrastructure driver. The 
changes to the network are listed in the table with time and descriptive names. It is 
allowed to have several changes in the same year. You can use the „Show / Edit 
network at time‟ button to open a window with a single network map displaying the 
network at the chosen time (incorporating all specified network changes up to that 
time). You can add or remove elements from this network or change the accessibility 
type of an element. You can store the changes you made as a new network change 
and give a descriptive name. You can view and edit each network change in isolation in 
the modeller user interface via Main window → Drivers → Parameters → Land use → 
Accessibility → „Go to infrastructure layers‟ button → Infrastructure layers window (for 
more information see the section Accessibility). 

Displaying an infrastructure network 

 Go to Main window → Driver → Policy measures  → Infrastructure. 
 Select “Transport network” from the Network list. 
 Click the „Show / Edit network at time‟ button at the bottom of the window. A 

window will open where you can select the simulation time for which you want to 
display the network. 

 Select a time from the list and click the OK button. A map window will open 
displaying the selected infrastructure network at the selected time. You can draw 
links in this network, remove links or change the type of a link. Therefore, the nodes 
of each link are displayed as small circles. You can hide these by clicking on the 
„Network tools‟ button in the tools pane in the bottom-right of the map window and 
deselecting „Show nodes‟. For more information, see the section Network tools. 

Creating network changes 

 Go to Main window → Driver → Policy measures  → Infrastructure. 
 Select “Transport network” from the Network list. 
 Click the „Show / Edit network at time‟ button at the bottom of the window. A 

window will open where you can select the simulation time for which you want to 
display the network. 

 Select a time from the list and click the OK button. A map window will open 
displaying the selected infrastructure network at the selected time. 

 To add a link, select which type of link to add from the „Link color‟ legend, then click 
the „Add link‟ button on the Network tools and draw the link in the map by dragging 



 

Doc # 2330707 Page 41 

the mouse from the start point to the end point. You may first want to zoom in on 
the area of interest. Note that you can only draw straight lines. 

 To remove a link, zoom in on it, right-click on it and select Delete from the context 
menu that will pop up. 

 To change the type of a link, zoom in on it, right-click on it and select Properties 
from the context menu that will pop up. A window will open where you can select 
the infrastructure type. 

 Close the map window to save your changes as a new network change. You will be 
asked to enter a name for the change and a file name where the map will be saved. 
It‟s best to save this in a subfolder of the project file. Note that the system always 
creates incremental network change maps, meaning only the nodes and links that 
have been added, removed or changed are saved. 

Importing a network 

When data on infrastructure developments is available or can be prepared in a GIS (as 
an ESRI shape file), you can import these directly in WISE. You can either import a 
complete network that replaces the previous network in a simulation run, or you can 
import a network that only indicates which network elements should be added or 
removed. In the latter case, the network needs to have a property (column) called 
“DeltaType” (case insensitive) with value 1 for all elements that should be deleted. If 
the property is missing, all elements in the file will be added to the network. 
 
 Go to Main window → Driver → Policy measures  → Infrastructure. 
 Select type of infrastructure network that you want to import from the Network list. 
 Click the „Import network change‟ button. A window will open where you can enter 

the information required to import a network. 
 Click on the browse button inside the File box to open the file to import. 
 Select the Incremental check box if the network to import only contains the 

elements to be added or removed. Clear the check box if the network should 
replace the existing network at the specified simulation time. 

 Click the OK button when you have entered all information. The network change 
will be added to the in the Main window. 

3.3 Visualising indicators 

The integrated model in WISE contains several components that calculate policy-
relevant indicators. In order to calculate these, the model also calculates various other 
results, which are not useful for scenario-analysis, but can be used by modellers to 
calibrate or validate the models. The Indicators tab in the Main window provides 
organised access to all policy-relevant output calculated by the integrated model. 
 
Indicators are organised in four groups in the user interface:  

 Social indicators 

 Economic indicators 

 Environmental indicators 

 Land use indicators 
 
Some of these indicators describe a state or a condition at the current simulation time 
(e.g. the maps under the Environmental indicators section and the age-cohort figure). 
Other indicators show a change over time. Note that these will be empty when you first 
open the simulation, or after you have reset the simulation, but are filled with data as 
the simulation progresses and display the full picture at the end of a simulation. You 
can visualise the social, economic, environmental and land use indicators at any point 
in time during a simulation. 
 
Social indicators 
On the Population tab of the social indicators, you will find a population pyramid for the 
current simulation time and the district selected in the „Population for district‟ list. You 
can click the graph buttons to display a graph window that shows the evolution of the 
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total, male or female population for the selected district over the course of the 
simulation period. 
 
On the Density tab, you will find a table of average population densities for the current 
simulation time and for the residential land use selected on the „Land use‟ list. Density 
values that lie within the upper and lower bound are indicated with a green background; 
otherwise a red background will be displayed. This is an indication that the total 
residential area in a district will be over- or underrepresented in the simulation, given 
the simulated population in that district. 
 
Economic indicators 
All economic indicators are displayed as graphs that show the evolution of an indicator 
over the course of a simulation. You can open these graphs by clicking the graph 
buttons. The lists before the graph buttons display the sectors for which the indicator is 
relevant, as well as an entry for “All sectors”. This will display a total value over all 
sectors in the economic model. The unit of each indicator is displayed to the right of the 
graph buttons. 
 
Environmental indicators 
The environmental indicators in WISE include maps and graphs. The graphs work the 
same way as for the economic indicators. The maps can be opened by clicking the 
„Show map‟ button for an indicator. These all display the value of the indicator for the 
current simulation time. To save maps for different moments during a simulation run, 
see the section Log maps. 
 
Land use indicators 
Land use indicators display a dual graph for each land use function that can be opened 
by clicking the „Show‟ button. The upper graph displays the demand for land as 
calculated by the population model (for residential land uses) or the economic model 
(for all other land uses). The lower graph displays the amount of land that was 
allocated by the land use change model. When the graphs coincide, all demanded land 
could be allocated. When the graphs deviate from each other, this means that less land 
is available for a land use than what is demanded based on the projected growth of 
population and the economy. The competition between land uses is taken into account 
in this respect. Hence, you will likely see land scarcity affect agricultural land uses, but 
not residential or commercial land uses. 

3.4 Analysing results 

The final step of the impact assessment study is to analyse results within an integrated 
scenario (e.g. the temporal evolution of an integrated scenario) or to compare a set of 
integrated scenarios. 
In order to analyse spatial results (maps) more carefully it is often helpful to analyse 
them pixel by pixel or to compare only the land use type you are interested in.   
You have run the simulation with different integrated scenarios and saved result maps 
using Log maps command on the Options menu. To investigate these maps you will 
use the Map Comparison Kit (MCK). This is a tool that contains a multitude of 
algorithms to compare maps on a pixel by pixel basis. For more information, we refer to 
the user manual that comes with the MCK. 

Short overview of the MCK 

The MCK looks as depicted below.  
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The Map Comparison Kit application window consists of the Menu bar, the Toolbar and 
the Work pane. You can simultaneously open different windows for maps and statistics. 
Furthermore, it is possible to keep the Comparison Settings dialog window opened 
while working with the tool: 

 The 1st Map window contains the first map to compare/analyse. You can open it by 

clicking the „1‟ icon on the toolbar ( ). The list next to the toolbar displays which 
map is selected. You can select a different map from the dropdown list and the map 
displayed in the 1st map window, as well as the result map and results statistics will 
be updated immediately. 

 

 The 2nd Map window contains the second map to compare/analyse. It works the 
same way as the 1st map window. 

 

 The Result map window contains the result map. It can be opened by clicking the „1 

/2‟ icon on the toolbar ( ). This map shows the spatial result of the map 
comparison. Depending on the selected comparison method the results are 
presented in a continuous scale or a nominal scale. 

 

 The Result statistics window contains the numerical (non-spatial) results of the last 
performed map comparison. It can be opened by clicking the table icon on the 

toolbar ( ). 
 

 The Comparison settings dialog window allows you to change the settings of the 
current comparison algorithm. It can be opened by clicking the „+-„ button on the 

toolbar ( ). 

1
st
 Map 

Menu bar Toolbar 

2
nd

 Map Result map 

Comparison settings 

Result statistics 

Work pane 
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Comparing maps in the MCK 

First we will analyse how the maps of the Baseline integrated scenario changes over 
time: 
 Go to the Analysis tab in the navigation pane on the left hand side of the Main 

window of WISE. 
 Click the „Start MCK‟ button. The Open window of the MCK opens. The MCK log 

file that has been generated by the „Log maps‟ functionality in WISE will be 
preselected in the Open window. 

 Click the Open button. The MCK log file will be loaded. 
 Select which type of maps you want to compare from the left-most list on the 

toolbar. The lists for the first and second map will be updated according to your 
selection. 

 Select the first and second map to compare. Click the 1 or 2 icons on the toolbar to 
display these maps. The maps in the list are ordered by simulation name (as 
entered in the „Log settings‟ window in WISE) and by year. 

 Select a comparison algorithm by clicking the balance icon on the toolbar ( ). For 
categorical maps, such as land use, zoning or threatened environments, the „Per 
category‟ or Kappa algorithms will be most useful. For numerical maps, the „b – a‟ 
or „b divided by a‟ algorithms will be most useful. 

 Click the „1/2‟ icon on the toolbar ( ) to display the comparison map and click the 

table icon ( ) to display overall comparison statistics. 
 Some comparison algorithms can be further refined with special settings. For 

example, the „Per category‟ comparison algorithm can be refined by selecting which 

category to compare. Click the „+-„ icon on the toolbar ( ) to adjust these settings. 
If a comparison algorithm has no settings, this icon will be greyed out. You can click 
the Apply button in the „Algorithm settings‟ window to update the comparison results 
directly. 

 
 



 

Doc # 2330707 Page 45 

4. Modeller interface 
This section deals primarily with the interaction between the Modeller and the software. 
The modeller can have more detailed access to the underlying models of the system 
diagram to update data and parameters and to check the output. For details about the 
models, we refer to the accompanying Model descriptions of WISE. 
 
Only a global overview of the model itself and the features which are not directly linked 
to the model description will be described in this user manual. 
 
Detailed information about how to update data and parameters through the modeller 
user interface is given per individual model in the section Individual model components. 
Notice that setting the parameters is part of the calibration of the system. Changing the 
parameter settings can have a major impact on the behaviour of the system. If you do 
not have a good understanding of the individual models, we suggest you to use the 
default settings.  

4.1 Overview of the system diagram 

To access the modeller user interface,  
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane. The system diagram of the 

integrated models becomes visible in the content pane on the right hand side of the 
Main window. 

 
The system diagram in the content pane is the most essential feature of the user 
interface for the modeller. It shows an overview of the structure of the integrated 
models at the most abstract level and enables access to the details of the model at this 
level but also at lower levels. You should learn to use it as a graphical explorer of the 
model. You can change neither the model structure, nor its graphical representation. 
 

 
 
The WISE system has been implemented by means of the software framework 
Geonamica. Geonamica models consist of Model Building Blocks (MBBs) that contain 
the code and/or data required to calculate and execute mathematical operations 
varying from a single operation, such as the sum of two numbers, to a complex set of 
interlinked operations (set of mathematical equations). Model Building Blocks are 
graphically represented in the user interface by means of a rectangle with the name of 
the MBB in it. They are connected to one another by means of MBB-Connectors. 
 
The WISE MBBs are structured by 4 spatial levels: NZ & World, Region, District and 
Local level. The MBBs incorporated in WISE are: 

 Climate change scenarios (Climate model) 

 Hydrology (Hydrology model) 
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 Water quality (Water quality model) 

 Economics (Economic model) 

 Demography (Population model) 

 Terrestrial biodiversity (Terrestrial biodiversity model) 

 Land use (Land use change model) 

 Spatial indicators (not available in this version) 
 
The representation of the system diagram in the Main window has been created with 
the help of the following basic elements: MBBs, MBB-Connectors, Connections, and 
MBB-Dialog windows. 

4.2 Model Building Blocks (MBB ) 

Model Building Blocks are represented in the system diagrams by means of a rectangle 
with the name of the MBB displayed in it. 
 
An active MBB is represented in black. When you move the mouse pointer over such a 
block its colours becomes inverted. Next, if you click on it, a dialog window will be 
open. This dialog window is the graphic user interface of the MBB. It has the function to 
receive the user input and to display the model output.  

4.3 Connectors and connections 

Variables and parameter values can be passed from one MBB to the other via 
Connections, or Pipes. MBBs will dispense variable or parameter values with the rest 
of the models via Out-connectors, and will take-in information from other MBBs via In-
connectors. 
 
The actual data exchange between MBBs is possible via a Connection between an 
Out-connector of the issuing block and the In-connector of the receiving block. Once 
there is a variable or parameter value that is exchanged, a connection is displayed in 
the diagram.  
 

Symbols Connector 

 
In-Connector 

 
Out-Connector 

4.4 Dialog windows 

Each MBB has a dialog window associated with it. It is the vehicle that permits the 
interactive exchange of information between the user and the Model Building Block. 
The MBB communicates the results (output) of its numerical operations to the user and 
it takes in the data entered (input and parameter) by the user that are required for the 
execution of the MBB. It concerns data that are internal to the MBB which it does not 
get from other MBBs via its In-Connectors. 
 
Clicking on one of the model names gives you access to the underlying model. In 
general, the dialog window that pops-up is organised in such a way that the (external) 
input, parameters, and output are displayed from top to bottom. For some MBBs, the 
structure of the dialog window might be different according to the features of the MBBs, 
such as the Economic model. 
 
In WISE, the input and output are organised by map, map file, graph, single value and 
table. The user can find the detailed description about how to edit input and display 
output by the categories of map, map file, graph, single value and table in the section 
Editing Input and displaying output.  
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Information on all of the underlying models and their data and parameters can be found 
in the Model description reports of WISE. For each individual model component, see 
the section Individual model components.  

4.5 Individual model components 

Climate model  

Projected changes to 2050 of New Zealand annual rainfall, temperature and potential 
evapotranspiration (PET) corresponding to three Intergovernmental Panel on Climate 
Change (IPCC) global greenhouses gases emissions scenarios (low, medium, and 
high) have been produced as input for the climate model in WISE.  
To access the modeller user interface for the Climate model, 
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane on the left side of the window. The 

system diagram displays in the content pane on the right side of the window. 
 Click the Climate change scenarios MBB box at the NZ & world level in the system 

diagram. The Climate model dialog window opens. 
 
The Climate model dialog window is structured so that the Input and Output parts are 
displayed from top to bottom. In WISE, maps for six climate variables are required as 
the input in the climate change model. They are: 

 Rainfall trend: the trend for mean annual rainfall 

 Rainfall variation: the variation between the actual rainfall and the trend for rainfall 

 Potential evapotranspiration trend: the trend for mean annual potential 
evapotranspiration (PET) 

 Potential evapotranspiration variation: the variation between the actual PET and the 
trend for PET 

 Temperature trend: the trend for mean annual temperature 

 Temperature variation: the variation between the actual temperature and the trend 
for temperature 

 
Depending on the climate change scenario, different maps and different combinations 
are used. These maps are raster maps with spatial resolution of 0.05° lat/long 
(approximately 5km) grid. The values of each map represent the mean annual values 
for that type of map. 
 

 
 

On the top part of the Climate model dialog window, you can select the climate variable 
of interest from the dropdown list next to Time series. For all the variables, you can 
change the map of interest by clicking on the browse button next to the specific time 
and upload a new map.  
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 For the trend type variables, such as rainfall trend, PET trend and temperature 
trend, you can add a map for a specific year by using the Add time… button on the 
right-top of the dialog window. The system calculates the interpolated values for the 
year that are not explicitly defined. You can also delete a map for a specific year by 
using the Remove time button the right-top of the dialog window. 

 

 For the variation type variables, such as rainfall variation, PET variation and 
temperature variation, the maps of 36-year period from 1972 to 2007 are used 
repeatedly for the period 1972-2007, 2008-2043 and 2044-2079. These data will be 
used to superimpose the natural year-to-year variations of these variables upon the 
climate change trends for each emission scenario to 2050. You can add a map for 
a specific year by using the Add time… button on the right-top of the dialog window. 
You can also delete a map for a specific year by using the Remove time button the 
right-top of the dialog window. If there is no variation map for a specific year, then 
the system takes value 0 as the variation for this map and for this year. 

 
In WISE, several predefined climate change sub-scenarios are available in the 
scenario manager. For more information, see the section Managing sub-scenarios. 
 
A climate map (rainfall map, PET map or temperature map) for a specific year is the 
sum of the climate trend map and the climate variation map for that specific year. For 
instance, the rainfall map for a specific year is the sum of the rainfall trend map and the 
rainfall variation map. It holds true for the PET map and temperature map.  
 
On the lower part of the Climate model dialog window, you can view the climate maps 
for the current simulation year by clicking the Show ### button where ### represents 
the climate map of interest.  
 
The values from the climate change scenarios will be used as input information for the 
Hydrology model. 

Hydrology model 

The hydrology model is a simple hydrological simulation model for annual water runoff. 
It includes the impacts of spatially-varying climate, soil and vegetation hydrological 
response. The outputs of the model are the annual runoff for each year, and the 
expected water yield in the driest summer month.  
 
To access the modeller user interface for the Hydrology model, 
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane on the left side of the window. The 

system diagram displays in the content pane on the right side of the window. 
 Click the Hydrology MBB box at the Region level in the system diagram. The 

Hydrology model dialog window opens. 
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The Hydrology model dialog window is structured so that the Input, Parameters and 
Output parts are displayed from top to bottom. In WISE, besides the output from the 
climate change scenarios, six kinds of maps are required as the input in hydrology 
model. They are: 

 Rainfall seasonality map 

 Potential evaporation seasonality map 

 Mean number of rain days map 

 Profile readily available water map 

 Flow seasonality map 
 
These maps are raster maps with a spatial resolution of 500 meter.  
 
In the Input part of the Hydrology model dialog window, you can view and edit the input 
maps for the hydrology model by clicking on the Show/edit… button next to the input 
map of interest.  
 
In the Parameters part of the Hydrology model dialog window, you can view and edit 
the Canopy storage capacity for each land use by clicking on the cell of interest and 
entering a new value. In the hydrology model, the changes in climate affect the rain 
and potential evaporation, whereas changes in vegetation affect mainly the water 
holding capacity of the plant canopy. 
 
In the Output part of the Hydrology model dialog window, you can view the annual 
runoff map and the summer flow yield map for the current simulation year by clicking 
the corresponding button at the bottom.  

Water quality model 

The water quality model in WISE system is aimed at explaining and predicting average 
annual loads of nutrients from present and future distributions of point sources, climate, 
soil types, land slope, drainage characteristics, and land uses. 
 



 

Page 50 Doc # 1737699 

 
 
To access the modeller user interface for the Water quality model, 
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane on the left side of the window. The 

system diagram displays in the content pane on the right side of the window. 
 Click the Water quality MBB box at the Region level in the system diagram. The 

Water quality model dialog window opens. 
 
The Water quality model dialog window is structured so that the Input, Parameters and 
Output parts are displayed from top to bottom. In WISE, besides the information on 
climate and land use, two kinds of input are required in the water quality model. They 
are: 

 Catchment area look-up table 

 River network map 
 
You can upload a new catchment area look-up table by clicking the browse button next 
to Catchment area look-up table on the top of the window and double-clicking on the 
new file. The catchment area look-up table is a binary file containing the following 
information:  

 A list of entries with for each entry 

 Unsigned integer (32-bit) with row index in higher 16 bits and column index in lower 
16 bits 

 Unsigned integer (32-bit) with index of catchment where the index is the link ID in 
the river network 

 Unsigned short (16-bit) with the area (in m2) of the cell that lies in the catchment 
 
You can upload a new river network by clicking the browse button next to River 
network and double-clicking on the new map. The river network map is in shape 
format. The reach network is a dendrite system of reaches and nodes. Each reach has 
a single sub-catchment associated with it. A reach may also have a lake associated 
with it. Information on a reach and its associated catchment characteristics are stored 
in the properties table for each reach.  
 
You can view the river network by clicking the Show/edit map… button next to River 
network. The Input river network map window opens. You can zoom in the area of 
interest and right-clicking on the reach of interest. The selected reach becomes red. 
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Click on the Properties on the context menu. The Properties dialog window opens 
where you can edit the properties for the selected reach. 
 

 
 
After editing the river network map, the system will ask you whether or not save the 
changes you made. Click on the Yes button and giving a new file name to save the 
changed river network map. 
 

 
 

In the water quality model, the point sources of nutrients are delivered from land to 
water by two ways: drainage and rain. You can view and edit the mean delivery value 
over river network for each deliver type in the table in the Input part.   
 

 
 
In the Parameters part of the Water quality model dialog window, you can view and edit 
the source coefficient phosphorus, source coefficient nitrogen, drainage exponent 
phosphorus, drainage exponent nitrogen, rain exponent phosphorus and rain exponent 
nitrogen for each land use in the Land use/parameter table. You can view and edit the 
reservoir decay, stream attenuation low flow and stream attenuation high flow per 
nutrient type in the Nutrient /parameter table. 
 
In the Output part of the Water quality model dialog window, you can view the annual 
phosphorous load map and the nitrogen load map for the current simulation year by 
clicking the corresponding button at the bottom of the Water quality model dialog 
window.  

Economic model 

The economic model in WISE is designed to simulate the combined environmental and 
economic implications of economic change in the Waikato Region. The model is driven 
by scenarios of economic growth. 
 
To access the modeller user interface for the Economic model, 
 Go to the Drivers tab of the Main window. 
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 Click the Parameters icon in the navigation pane on the left side of the window. The 
system diagram displays in the content pane on the right side of the window. 

 Click the Economics MBB box at the Region level in the system diagram. The 
Economic model dialog window opens. 

 
The Economic model dialog window is divided over several tabs: Sector filter, Sector-
land use correspondence, Consumption, Demand, Land use constraint, Supply and 
Indicators. 

Scrolling tabs 

Use the icons at the top-left of the „Economic model‟ window to scroll the tabs, when 
some of them are not visible. 
 

Use this command To… 

 Move to the left end tab 

 Move tabs to left 

 Move tabs to right 

 Move to the right end tab 

 
The „Economic model‟ window mainly consists of tables. Some of the headings of the 
tables are not displayed completely. The complete heading is displayed when you 
hover the mouse cursor over it. You can change the width of a column by dragging the 
right edge of the column heading. Double-click this edge to size the column to fit the 
contents. 

Sector filter 

The „Sector filter‟ tab shows which sectors are displayed on various lists in the Main 
window. You can adjust the selection by selecting or clearing the check boxes.  

Sector – land use correspondence 

On the top of the „Sector – land use correspondence‟ tab, the „Sector to land use 

correspondence‟ table is shown. Here we specify the extent to which each land use 
function contributes to each sector. The ratio coefficients in the Sector to land use 
correspondence table are used to convert land use demand per sector to land use 
demand per function. 
 
You can view or adjust the relation between land use functions and sectors by clicking 
on the corresponding cell in the table, and adjusting the coefficient. Note that the 
values are fractions and that all fraction for each sector should add up to exactly 0 or 1. 
 
Press the Apply button under the Sector to land use correspondence table to confirm 
the modifications. The system allows you to undo changes in coefficients you have 
made since its last applied state by means of the Reset button. The Apply and Reset 
buttons are only active after a change has been made. 
 
On the bottom of the „Sector – land use correspondence‟ tab, you can find the „Inverse 
correspondence‟ table. This shows the extent to which each sector contributes to each 
land use function. The coefficients in this table will be used to convert land use demand 
per function to land use demand per sector. The values in the „Inverse correspondence‟ 
table are updated after each simulation step. 

Consumption 

The Consumption tab displays the household consumption per sector. This is updated 
after each simulation step according to the growth of population. People of different 



 

Doc # 2330707 Page 53 

ages or gender can have a different effect on total consumption, which is captured in 
the „Consumption scalars‟. 

Demand 

The Input section of the Demand tab displays four components of final demand: 
International exports, Interregional exports, Gross fixed capital formation and Changes 
in inventories. Different values can be entered for different times. The Time list shows 
for which simulation times a value has been specified. In between these times, values 
will be linearly interpolated according to the previous and next specified time. You can 
add or remove times to the list using the corresponding buttons. 
 
The total of these four components and household consumption is the „Final demand‟ 
displayed in the Output section. These values are multiplied with the „Inverse Leontief 
matrix‟ of the Parameters section to calculate the „Unconstrained output‟ displayed in 
the Output section. These values will be used to calculate land use demands in the 
next tab. 

Land use constraint 

After the „Unconstrained output‟ is calculated, the values are converted from a 
monetary value per sector to a surface area per land use function. This is done using 
the „Sector to land use correspondence‟ and the „Land productivity‟. On the top of the 
Land use constraint tab, you can view and edit the Land use productivity per sector. 
The Land use productivity is used to convert between monetary values and surface 
area. 
 
On the bottom part of the Land use constraint tab, two tables with two columns each 
are displayed. The columns have the following meaning: 

 The Unconstrained land use demand [ha] per land use function is the demand from 
the economic model. 

 The Allocated land use [ha] per land use function is the amount of land allocated by 
the land use change model. 

 The Output corresponding to allocated land use per sector displays the amounts 
from the „Allocated land use‟ column after they have been converted back to 
monetary values. 

 The Change in output due to land use constraint per sector is the difference 
between the „Unconstrained output‟ (Demand tab) and the „Output corresponding to 
allocated land use‟. 

Supply 

On the top part of the Supply tab, the system allows you to view and edit the Ghosh 
matrix from sector to sector. 
 
On the bottom part of the Supply tab, you can observe the Change in final demand, the 
Constrained final demand and the Constrained output per sector. The last is used for 
the calculation of the indicators. 

Indicators 

On the top of the Indicators tab, it shows the Input table where you can view and edit 
the initial values of the indicators per sector. It should be noted that the initial value 
must be non-negative. In the Parameters table you can view and edit the Rate of 
change in multi-factor productivity and the Rate of change in eco-efficiency per sector. 
On the bottom, you can see the output of the indicators per sector. 

 The Current growth factor in the first column of the Output table shows the ratio of 
output in the current year to that of the previous year. 

 Each year, all the indicators are multiplied by the growth factor and corrected for 
the corresponding rate-of-change. 
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Population model 

The population model in WISE system generates possible future populations, referred 
to as population projections, starting from a given base population and assumptions 
about the demographic processes of fertility, mortality and migration. 
To access the modeller user interface for the Population model, 
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane on the left side of the window. The 

system diagram displays in the content pane on the right side of the window. 
 Click the Demography MBB box at the District level in the system diagram. The 

Population model dialog window opens. 
The Population model dialog window is composed of two tabs: Population and 
Residential land use demand. 

Population 

The Population tab on the Population model dialog window is structured so that the 
Input, Parameters and Output parts are displayed from top to bottom.  
 

 
 
All data inputs to the population model (base population, migration rates, fertility rates, 
and survivorship rates) are contained in a Microsoft Excel workbook. This Excel 
parameter file includes the data necessary required by the population model for a 
simulation: 

 Survivorship rates by single year of age and gender per district  

 Fertility rates by single year of age for all females aged 13-49 per district 

 Base population by single year of age and gender per district 

 Additional migration from Economic Development Assumptions (EDA) per district 

 Migration rates by single year of age and gender per district 
 
In the Input part, you can upload a new population parameter file by clicking the browse 
button next to Excel parameter file.  
 
You can view and edit the first year and the last year of the data in the Excel parameter 
file in the text box next to First year and Last year, respectively. The column B of each 
sheet in the excel parameter file is interpreted as the year that you determined in the 
text box next to First year. The year in the text box next to Last year just indicates the 
range of columns of each sheet that are available in the excel parameter file.  
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In the Parameter part of the Population model dialog window, first of all, you can view 
and change the value for Birth gender bias towards boys. 
 
The survivorship rates, fertility rates, and migration rates in the population model can 
all be altered in order to test the effect of different policies on the projected population. 
Of course, this would require some assumptions to be made about the impact of 
policies on the demographic variables. These policy levers are displayed in the table of 
the Parameters part: Fertility lever, Mortality lever, Net migration lever per district and 
EDA population effect per district in the start year and the end year of the simulation. 
The system takes the interpolated values for other years. 

 Fertility lever: the percentage of increase or decrease for the fertility rate 

 Mortality lever: the percentage of increase or decrease for the mortality rate 

 Net migration lever: the percentage of increase or decrease for the net migration 
rate 

 EDA population effect: the number of additional people that migrate to a region 
based on economic development assumptions 

 

 
 
You can view or edit the value by clicking the cell of interest and entering a new value.  
 

 
 
You can specify values for these parameters for a specific year. To add or remove a 
year, click on the Edit time… button on the top of the table. The Edit moments dialog 
window opens. Press the Add… button to add a specific year. Press Generates… to 
create a series of years. Click the Delete button to remove the selected year on the list. 
The system enables you to undo changes in moments you have made to its last 
applied state by means of the Reset button in the Edit moments dialog window. Click 
the OK button to confirm the changes that you made and close the Edit moments 
dialog window.  
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An empty column for the newly added year is displayed in the table. Select the check 
box next to Interpolate. The system takes the interpolated value for the newly added 
time on the basis of the values for its closest defined years in the table. The 
interpolated values are highlighted with yellow background. You can specify the values 
for the newly added time as well. Once you give a specific value for a parameter and 
for the newly added time, this cell is displayed with a normal white background again.  
 

 
 
In the Output part of the Population tab, you can view the output for total population, 
male population and female population by single year of age and per district for the 
current year of the simulation. You can also view the average life expectancy by 
gender per district and the natural increase in people and in percentage per district for 
the current year of simulation. Click the dropdown list under Output and select the 
variable of interest. The results for this variable are displayed in the table.  
 

 

Residential land use demand 

The Residential land use demand tab on the Population model dialog window is 
structured so that the Input, Parameters and Output parts are displayed from top to 
bottom.  
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The table in the Input part shows the population density per residential land use class 
and per district. You can view and edit the density in this table. The residential land use 
classes include:  

 Residential – Lifestyle blocks 

 Residential – Low density 

 Residential – Medium to high density 
 
In the Parameters part of the dialog window, the proportion of people that live in each 
residential class is displayed per district and for the selected year. You can view and 
edit these values by clicking the cell of interest and entering a new value. The sum of 
the proportions of people for each district should be exactly 1. If this is true, the Sum 
column in the table is highlighted with green background; otherwise, it will be 
highlighted with red background. That means you should change the values for that 
district to meet the condition that the sum of the three residential classes should be 1. 
 
The values of the proportions of people for the start year of the simulation are given by 
default. You can specify the values of proportion of people for a specific year. To do so, 
click the Add time… button in the Parameters part. The Enter date and time dialog 
window opens. In the text box, you can enter a new year for which you want to specify 
the values. Once you press the OK button, the newly added year will be displayed on 
the dropdown list next to Time on the Residential land use demand tab. 
 

 
 
By default, the system takes the values for the previous specified year as the values for 
the newly added year. Select the newly added year from the dropdown list next to 
Time. You can now view and specify the values for this year in the table. The system 
takes the values for undefined years on the basis of linear interpolation of the values 
for its two closest defined years. 
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You can remove the added year(s) from the dropdown list next to Time by clicking on 
the Remove time button on the top of the table. The start year of the simulation is not 
removable. 
 
In the Output part of the Residential land use demand tab, the table shows the land use 
demand in cells per residential land use class and per district for the current simulation 
year. 
 

 
 

Land use change model 

To access the modeller user interface for the Land use change model 
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane on the left side of the window. The 

system diagram is displayed in the content pane on the right side of the window. 
 Click the Land use MBB box at the Local level in the system diagram. The Land 

use change model dialog window opens.  

Land use classes 

Land use is classified in categories, some of which are modelled dynamically while 
others remain static. Dynamic land uses are called Functions or Vacant land uses. 

 Vacant states are classes that are only changing as a result of other land use 
dynamics. Computationally at least one vacant state is required. Typically 
abandoned land or natural land use types are modelled as vacant state, since they 
are literally vacant for other land uses or the result of the disappearance of other 
land use functions. 

 

 Functions are land use classes that are actively modelled, like residential or 
industry. Functions change dynamically as the result of the local and the regional 
dynamics. 

 
The non-dynamic land uses are called Features. Features are land use classes that 
are not supposed to change in the simulation, like water bodies or airports. However, 
they do influence the dynamics of the Function land uses, and thus influence their 
location. For example a Function „Tourism‟ would be influenced (expressed by a spatial 
interaction rule) by the occurrence of the Feature „Beach‟, due to the simple fact that 
tourists tend to recreate near the sea at the beach. 
 
In WISE, the following land uses are modelled: 
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Land use States 

Bare Surfaces Vacant 

Indigenous Vegetation Vacant 

Other Exotic Vegetation Vacant 

Wetland Vacant 

Residential - Lifestyle Blocks Function 

Residential - Low Density Function 

Residential - Medium to High Density Function 

Commercial Function 

Community Services Function 

Horticulture Function 

Biofuel Cropping Function 

Vegetable Cropping Function 

Other Cropping Function 

Dairy Farming Function 

Sheep, Beef or Deer Farming Function 

Other Agriculture Function 

Forestry Function 

Manufacturing Function 

Marine Feature 

Aquaculture Feature 

Utilities Feature 

Mines and Quarries Feature 

Urban Parks and Recreation Feature 

Fresh Water Feature 

Airports Feature 

Land Outside Study Area Feature 

Marine Outside Study Area Feature 

Overview 

The Land use model dialog window has been grouped in so-called Control pane and 
Content pane which are indicated in the red and in the green frame respectively in the 
figure depicted below. 
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In the control pane, you can select a land use class of interest in the land use change 
model from the dropdown list next to Land use. The selected land use type is displayed 
on the right side of the control pane.  
 
The content pane is structured by tabs. Each tab has its own dialog window allowing 
you to set parameter values and view results. The content of these dialog windows for 
the same tab can differ per land use type.  
 
The content pane is structured by Land use tab, Neighbourhood tab, Accessibility tab, 
Suitability tab and Zoning tab.  
 
Most of the contents in the content pane are related to the selected land use in the 
control pane except that the Input and Parameters parts on the Land use tab, 
Neighbourhood tab and Zoning tab are for all the land uses. 

Land use 

Click the Land use tab to access the contents depicted as the figure above. 
 
The Input part is on the top of the Land use tab. The system allows you to view or edit 
the initial land use map here. You can change the initial land use map by clicking on 
the browse button next to Initial land use map and selecting the file that you want to 
import.  
 
A Map window of Initial land use map opens after pressing the Show/Edit… button on 
the left side of the text box. You can view or edit the initial land use map via the map 
window. For more information about how to edit a land use map, see the section Grid 
tools. 
 

Control pane 

Content pane 
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Land use changes after the start year of the simulation can be incorporated as land use 
deltas. These can be used to change the presence or location of the incorporated 
feature classes. Since vacant and function classes are allocated by the model, 
changes in these can not be made explicitly in the system. It is recommended to 
prepare your land use deltas map in a GIS package before you import it into WISE. 
The land use delta map should only include the information on the land use feature 
classes. If you have a new land use map for a specific year, you can extract the 
location of the land use feature classes in a GIS package into a new land use delta 
map. This new extracted map will be used as one land use delta for specific year. 
 
You can use the Add time… or Remove time… button to add or delete the land use 
changes.  
 
When you move the mouse over a land use change on the map file list and click on it, 
this land use change is highlighted with blue background. Then press the Show current 
land use map and selected changes… button at the bottom of Input section, and a 
Land use changes map window opens which is an overlay of the land use map for the 
current simulation and the selected land use changes.  
 
The Parameters part is in the middle of the dialog window. You can edit and view the 
general parameters for the land use change model here: Random coefficient and Total 
potential formula. These parameters work for all the land uses. In this version of 
software, the total potential formula is not editable. 
 
The random coefficient controls the stochastic perturbation effect to simulate the effect 
of unpredictable occurrences. The system enables you to enter the Random coefficient 
in the Parameters part on the Land use tab. The value of this parameter must be not 
less than 0. According to our experience, range of (0, 2) is recommended. A value of 0 
means no random effects. 
 
You can determine the Random seed to run the simulation.  

 Select the radio button next to Variable to run the simulation in full random mode.  

 Select the radio button next to Fixed to run the simulation in a pseudo-random 
mode. You can enter the number of random seed in the text box next to Fixed to. 
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The total potential for function states combines the effect of the neighbourhood, 
suitability, zoning and accessibility. The total potential for vacant states is a function of 
its suitability only. The default total potential algorithm is displayed in the text box under 
Total potential formula.  
 
There are two kinds of output maps on the Land use tab: the total potential map and 
the current land use map. 
 
You can view the total potential map of the current simulation year for the selected 
vacant or function land use by pressing the Show total potential map button in the 
Output part. A potential map displays the transition potential of a cell to allocate to the 
land use specified. On the basis of the transition potentials the model decides which 
land use will be allocated to each cell in the next simulation step. Colours in the total 
potential map range from red to green. Cells in red are not attractive for the indicated 
land use. In contrast, the green cells are. In the legend of the potential map you find 
next to the colour symbol two numbers. The figure to the right is the upper limit of the 
category. The figure to the left is the lower limit. Since the total potential map is only 
calculated for each vacant and function land use, the Show total potential map button 
in the Output part is not available for feature land uses. 
 

 
 
You can view the land use map of the current simulation year by pressing the Show 
current land use map button in the Output part.  

Neighbourhood 

The neighbourhood rules table displays the influence land uses have on each other. 
For example, people do not like to live close to an industrial area, so industry will have 
a negative influence on housing that decays as the distance between the two places 
increases. 
 
The influence that a certain land use has on another land use (or itself) is described as 
a function of the distance between two cells, which is represented as a piecewise linear 
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function. An example of such a function is shown in the figure below, where the points 
are connected by linear interpolation. In this graph, the distance runs along the 
horizontal axis and the vertical axis displays the influence that land use A has on land 
use B. 
 
Click the Neighbourhood tab on the „Land use change model‟ window to access the 
neighbourhood rules. The top table in this window displays the „Intertia/convertion 
effect for vacant land uses‟. This can be altered to change how vacant land uses are 
allocated, which only happens after all land use functions have been allocated. 
 

 
 
The „Neighbourhood effect for function land uses‟ table displays the neighbourhood 
rules. Click on a cell in this table to open a window in which you can change the 
influence rule. 

 You can drag one of the bubbles to change its value. 

 You can double-click on a bubble to edit the value precisely. 

 You can right-click on a bubble to remove it from the graph. 

 You can right-click outside any bubbles to add a new bubble to the graph. 

 You can click the „Display options‟ button to change how the graph is displayed. 
Here, you can also switch the distance unit between meters and cells. 

  
The system provides a table with the coordinate pairs for all discrete cell distances on 
the right hand side of the window. Influence values with a grey background represent 
interpolated values and cannot be changed. Influence values with a white background 
correspond to bubbles in the graph. These values can be edited in the table as well as 
in the graph. 
 
The neighbourhood influence rules describe the effect of one land use on another at 
each distance in the neighbourhood. These influences are accumulated to produce the 
neighbourhood potential in each cell for each land use function. Click the „Show 
neighbourhood potential map‟ button to display the neighbourhood potential map for 
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the land use selected in the „Land use‟ list at the top of the „Land use change model‟ 
window. 

Accessibility 

Click the Accessibility tab to access the contents depicted in the figure below. 
 

 
 
The accessibility for each function land use is calculated as a function of the distance 
to the nearest infrastructure network and the weight of this particular network. It 
represents how easy a location can fulfil its needs for transportation for a particular 
land use.  
 
The input of the Accessibility component of the land use change model is the 
Infrastructure layers in WISE. You can access the detailed infrastructure information by 
clicking the Go to infrastructure layers button in the Input part. The Infrastructure layers 
dialog window opens. 
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On the top of the dialog window, the default file names and file paths for the initial 
network layers are listed in the table by Network layer name. You can adapt an initial 
network layer for the specific layer by clicking on the browse button next of the specific 
layer and selecting the file that you want to upload. You can also view and edit the 
selected initial network map by clicking the Show / Edit selected button. 
 
Clicking the Add / remove infrastructure layers button to open the Add / remove 
infrastructure layers window. You can change the name of the network layers by 
entering a new name in the text box in the Network layer column. You can adapt the 
initial network layer by clicking on the browse button and uploading a new file.  
 

 
 
You can add a new network layer by clicking the Add.. button on the upper-right side of 
the Add / remove infrastructure layers window. After entering a name and loading the 
map for the new network layer, press the OK button. The newly added network layer 
will be displayed on the list of the Infrastructure layers. You can remove one existing 
network layer by selecting it and press the Remove button on the upper-right side of 
the window. 
 

 
 
You can also add a new accessibility type by clicking the Add… button on the lower-
right side. The Add accessibility type window opens. Enter the value and name for the 
accessibility type in the text boxes AccType value and Accessibility type name, 
respectively. The newly added accessibility type will be displayed on the list of 
Accessibility types. 
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Click the OK button at the bottom to confirm the changes and close the Add 
accessibility type window.   
 

 
 
Go to the Parameters part of the Infrastructure layers window. You can select your 
network of interest on the dropdown list next to Network layer. The detailed information 
for all the network changes for the selected layer are displayed in the table. 
 Click the Add… button to import a network change at a specific time for the 

selected network.  
 Click the Remove button to delete a network change at a specific time for the 

selected network. 
 You can view and edit each network change in isolation by selecting the change of 

interest from the table and clicking the Show / Edit selected button. 
 Click the Show / Edit selected button to display a network change in isolation at a 

specific time for the selected network.  
 
For more information about the network map window opened by pressing the 
Show/Edit selected button, see the section Network map window opened via the 
modeller user interface.  
 
You can view the entire network at a specific simulation time via the policy user 
interface. For more information, see the section Displaying an infrastructure network. 
The settings for network changes in the „Infrastructure layers‟ window links directly to 
the setting on the Policy measures page in the Main window. 
 
Go to the Accessibility tab of the Land use change model window. Accessibility 
parameters, which describe the influence of certain land uses to be close to elements 
of the infrastructure network play an important role in the allocation of the land use 
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functions. In the Parameters part, the system allows you to specify the parameters 
used for the accessibility maps for each function land use by following steps:  
 Select the land use of interest in the dropdown list Land use in the control pane. 
 Select the check box in front of Land use is build up if the selected land use in the 

model is contained in the set of urbanised land uses (for example residential land 
use). You need to determine whether a land use is build up or not for all land uses. 

 Select the check box in front of Land use is impassable if the selected land use is 
impassable (for example water). You need to determine whether a land use is 
impassable or not for all land uses. 

 Set the implicit accessibility parameters for each land use function. The Implicit 
accessibility values range from 0 to 1. Enter the Implicit accessibility parameter for 
the selected land use function on a build-up area in the text box next to Implicit 
accessibility for build-up areas. Enter the Implicit accessibility parameter for the 
selected land use function on a non build-up area in the text box next to Implicit 
accessibility for non-build-up areas. The text boxes of Implicit accessibility 
parameters are only available when one of the land use functions in the model is 
currently selected on the dropdown list. 

 Specify the distance decay and weight parameters per land use function.  The 
parameter table allows you to set the Distance decay for the effect of each 
Infrastructure type of the network on the selected land use function and it‟s Weight. 
The distance decay is the number of cells after which the effect is halved (for 
positive decays) or doubled (for negative decays). The weight determines the 
relative importance of the infrastructure element for the particular land use function. 
The distance decay can be positive – for example, industries like to be near 
highways – or negative – for example, natural areas are preferably not located 
close to highways. With positive decays this is then the maximum value and with 
negative decays the minimum value. To turn off the accessibility effect of a specific 
land use function, you can set its weight to zero.  

 
In order to visualize the accessibility map of a function land use, it is imperative that the 
simulation has been initialised (see the section Reset) or the accessibility has been 
computed (see the section Step). Use the Step command to compute the new 
accessibility maps after the network has been changed or when accessibility 
parameters have been changed. 
You can view the accessibility map of the selected land use function for the current 
simulation year by pressing the Show accessibility map button. The Accessibility for the 
selected land use function map window opens. Accessibility is expressed in the range 
0 to 1 and is displayed in colours varying from red to green: red meaning low 
accessibility (0) and green meaning high accessibility (1). All the network layers 
incorporated in the system are displayed as well in this map window. 
 
Since the accessibility map is only calculated for function land uses, the contents in the 
Parameters part and the Show accessibility map button in the Output part are not 
available if the selected land use is vacant or feature. 
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Network map window opened via the modeller user interface 

The user interface of the network map window opened via the policy user interface is 
different from the one opened via the modeller user interface. In this section, we focus 
the one opened via the modeller user interface. For the other one, please refer to the 
section Creating network changes. 

 You can view and edit the exact network changes for the selected network and for 
the specific year in the Network map window opened via the modeller user 
interface. 

 

 You can view the high-level overview of network layer for the selected network and 
for the specific year in the Creating network changes. 

 
For instance, the figure below shows the network map window opened via the policy 
user interface. All the roads on the Transport network layer for 2010 are displayed. 
 

 
 
The figure below shows the network map window opened via the modeller user 
interface. Only the expansion roads added for 2010 are displayed. 
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The title of the network map window indicates the descriptive name of the selected 
network and the selected year. As depicted in the figure above, besides the District 
boundaries layer, there is only one layer Road expansion 2010 visible in the layer 
manager pane, which shows the exact network changes for the selected time in the 
map pane.  
 
The legend pane consists of 4 legend tabs which are used for editing the legend of 
network map. The Link color and Link width tab are most useful. For more information 
about how to edit legend, see the section Legend editor. For all the networks, the 
categories of Acctype are used as the legend. 
 
The ratio buttons in the legend pane indicate that this network map is editable. You can 
view, edit the link properties or add new links on the selected network layer. 
 Select the network of interest from the dropdown list next to Network layer. 
 Select the network change for the time of interest to open the network change map 

window. 
 Double-click on the link of interest on the network changes map window. The 

Properties dialog window opens. All the available link properties of the selected 
network are displayed in the Properties dialog window. You can edit the link 
properties for the selected link from here.  

 If you want to add the selected link, enter value 0 in the cell for DeltaType.  
 If you want to delete the selected link, enter value 1 in the cell for DeltaType. 
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 Click Cancel to close the Properties dialog window. 
 Or click OK to confirm the change that you made. A message window appears to 

ask you whether you want to save the changes you have made or not.  
 

 
 

 Specify the name and path of the file that you want to save changes to. 

 Press Save. 

Suitability 

Click the Suitability tab to access the contents depicted as the figure below. 
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Suitability is represented in the land use change model by a map for each vacant or 
function land use. Values on the suitability map quantify the effect that physical 
characteristics of the land have on the possible future occurrence of land uses. The 
suitability maps can be created with the help of the Overlay-Tool. 
 
It is important to keep the default names of these suitability maps which are assigned 
by the Overlay Tool in the case you can import one or all suitability maps generated by 
Overlay tool by clicking the Import from Overlay-Tool… button. In the Import Overlay-
Tool maps dialog window, enter the time for which you want to import the suitability 
maps; select the location where you stored all suitability maps generated by Overlay 
tool; check the check box next to Vacant land uses are included in Overlay-Tool 
project. You need to verify if the suitability maps in the File column are corresponding 
to the land uses in the Land use column by switching on or off the check box 
mentioned above. Check the check boxes for each land use in the Import column to 
import the suitability maps for the checked land uses. 
 
If you generated suitability maps using other tools, for example the ArcGIS package, 
you need to import the suitability map one by one for the selected land use by clicking 
the browse button in the path edit box. 
 



 

Page 72 Doc # 1737699 

 
 
The system provides you the opportunity to set up the maximum suitability (for all land 
uses) by entering a value in the range of (0, 255) in the text box next to Maximum 
suitability on the top of the Suitability tab. This maximum suitability value should be the 
highest value on any suitability map in WISE. In general, if the suitability map is created 
in the Overlay-Tool with a maximum suitability value of 10, it can be used directly in 
WISE system.  
 
The path of the suitability map file for the function land use for the first date is displayed 
by default when you open the system. The system allows you to add or delete the 
suitability map for a selected land use at a specific time by clicking on the Add and 
Delete button.  
 
You can view or edit the suitability map for the selected vacant or function land use and 
for the selected time by clicking on the Show/Edit… button at the bottom of the 
Suitability tab.  
 
With the opened Suitability map window, it is possible to change the suitability value of 
individual cells. A higher value indicates a higher suitability. Suitability is displayed in 
the map in colours varying from red to green, representing values between 0 (not 
suitable) and 10 (perfectly suitable). Before you add the suitability map to the system, 
you have to ensure that the values on the map are integer values. For more information 
about how to work with an editable map, see the section Grid tools. 
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Zoning 

The zoning or institutional suitability is characterized by one map for each land use 
function. It is a composite measure based planning documents available from the 
national or regional planning authorities and can contains information from among 
others ecologically valuable and protected natural areas, protected cultural landscapes, 
buffer areas, etc. 
 
Click the Zoning tab to access the contents depicted as the figure below. 
 

 
 
The input to the Zoning part of the land use model are the Zoning maps which are 
generated with the help of the zoning tool in WISE. A zoning map is a categorical map 
with the zoning state values. No data values are depicted on the map as white.  
 
You can access the zoning tool via the user interface of the land use model by clicking 
the „Go to zoning tool‟ button on the Zoning tab. For more information about the zoning 
tool, see the section Zoning tool. 



 

Page 74 Doc # 1737699 

 
The categorical zoning maps need to be converted into numerical zoning maps which 
have numerical values to be used in the computation of the total potential. You can set 
the parameters to interpret the categories in the Parameters part of the Zoning tab. The 
conversion takes into account the De Facto zoning and the zoning state value for each 
land use function. 

 If a check box in the De Facto zoning table is selected for certain land use and for 
certain function, each year the zoning status will be corrected for the De Facto land 
use. For instance, the check box for Agriculture land use and for the Agriculture 
function is checked, if a location has agriculture on the calculated land use map, 
you introduce a new zoning plan where the agriculture is not allowed to develop on 
this location. The zoning status for agriculture function will still be allowed at this 
location. 

 

 If a check box in the De Facto zoning table is unselected for certain land use and 
for certain function, the zoning status will be corrected for the De Facto land use 
each year. For instance, when the check box for the Agriculture land use and the 
Agriculture function is checked, a location that has agriculture on the calculated 
land use map cannot be removed as a consequence of introducing a new zoning 
plan. Even though this new zoning plan indicates that agriculture is not allowed at 
that location. 

 
You can set the zoning state values for each land use function and each zoning state 
category in the Zoning state value table. The zoning state values will be used to 
calculate the numerical zoning map. You can view the numerical zoning map by 
clicking the „Show numerical zoning map‟ button on the Zoning tab. 
 

Terrestrial biodiversity model 

The terrestrial biodiversity model in WISE performs an analysis to identify unique 
combinations of land environments, protected areas, and land use. It combines 
information on all land uses including vegetation state with information from two other 
primary data sources to produce an indicator of ecosystem representativeness. 
To access the modeller user interface for the Terrestrial biodiversity model, 
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane on the left side of the window. The 

system diagram displays in the content pane on the right side of the window. 
 Click the Terrestrial biodiversity MBB box at the Local level in the system diagram. 

The Terrestrial biodiversity model dialog window opens. 
 
The Terrestrial biodiversity model dialog window is structured so that the Input, 
Parameters and Output parts are displayed from top to bottom.  
 



 

Doc # 2330707 Page 75 

 
 
Besides the land use map, the LENZ map and Protected area map are required as 
input in the terrestrial biodiversity model.  

 LENZ map: the Land Environments of New Zealand map shows information on land 
environments that serve as surrogates for ecosystems and habitats 

 Protected area map: Protected areas network of New Zealand map is a database of 
legally protected areas. 

 
You can upload a new LENZ map by clicking the browse button next to LENZ map and 
double-clicking the new map.  
 
You can add a protected area map for a specific year by clicking the Add time… button 
and importing a new map for the added year. You can delete a protected area map for 
a specific year from the list by selecting the map and clicking the Remove time button. 
You can view the protected area map by selecting it and clicking the Show /Edit button 
on the middle-right side of the Terrestrial biodiversity model dialog window. 
 
In the Parameters part of the Terrestrial biodiversity model dialog window, you can 
indicate whether a land use is a land use growing native vegetation by selecting the 
check box next to this land use. 
 
In the Output part of the Terrestrial biodiversity model dialog window, you can view the 
output map by clicking on the Show threatened environments map… button at the 
bottom of the window. The Threatened environments map window opens where 6 
categories are assigned to each environment: acutely threatened, chronically 
threatened, at risk, critically under protected, under protected and not threat category. 
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5. The WISE menu system 
This section explains the different functions that are available from the WISE menu 
system. Some Geonamica functions are not available in WISE. These are greyed out; 
they are visible in the menu in a light grey colour, but they do not result in further 
actions when invoked. Consequently, these functions are not described in detail in this 
section. 
 
Other functions are only accessible when they are relevant. For instance, the Stop 
command in the Simulation menu is only accessible when the simulation is running. 
 
The menus are treated as they appear in the Menu bar from left to right and per menu 
from the top to the bottom. Most commands in this section have already been 
described in other sections. You can find more detailed information for these 
commands through the links in the table.  

5.1 File menu 

You can use the File menu to open and save project files, and to exit WISE. The WISE 
system saves project files with a .geoproj extension attached to the file name. 
 

Option Function Link 

Open project Open a project file stored on a disk Section Opening a project 
file 

Save project Save changes to the current project file Section Saving changes 

Save project as Save a project under a different name Section Saving changes 

Export project Save a project and all associated data files to 
a new location 

Section Exporting a project 

Close project Close the project   

Recent file list Display the names and the paths of the 4 
most recently opened project files. If you 
select one of the 4 files, it will be opened 

 

Exit Quit Geonamica  

5.2 Simulation menu 

You can use the Simulation menu to control a simulation. The commands Update, Run, 
Stop and Reset can also be invoked when pressing the respective buttons on the 
Toolbar. 
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Option Function Link 

Update Recalculate variables that are affected by changes 
(except for the initial values and initial maps) via the 
user interface for the current simulation year. This 
command will not change the simulation time. 

Section Update 

Step Advance the simulation with one time step Section Step 

Run Advance the simulation till the next pause moment 
has been reached 

Section Run  

Stop Stop a simulation run Section Stop 

Reset Recalculate variables that are affected by changes 
(including the initial values and initial maps) via the 
user interface for the start year of the simulation. 
Switch the simulation clock back to the start year of 
simulation. 

Section Reset 

Pauses Set at which times a simulation run will be stopped 
automatically 

 

5.3 Maps menu 

You can use the Maps menu to open map windows. All available maps are structured 
hierarchically by themes in the menu. There are essentially two types of maps: input 
maps and output maps. Input maps are editable and output maps calculated for the 
current simulation time by the system are not editable. 

5.4 Options menu 

You can use the Options menu to personalise your workspace or to access the 
additional functionalities of WISE. 
 

Option Function Link 

Write to Excel Establish or interrupt a link between WISE 
and the Microsoft Excel Workbook 

Section Write to Excel 

Log maps Store maps produced by the system in the 
form of .rst files 

Section Log maps 

Animation maps Store dynamic maps produced by the 
system in the form of .gif animations 

Section Animate maps 

Preferences Manage various application settings of 
WISE.. 

Section Preferences 

 

Preferences 

Click Preferences on the Options menu to control various application settings. In the 
Preferences window that will open, you can select how to deal with file associations 
made by the application, whether to check for newer versions automatically and where 
to store temporary files created by the application. 

File associations 

File associations are a mechanism in Windows using which you can open a file in a 
specific program based on the files extension. For example, Microsoft Word files have 
an extension .doc or .docx. If you double click on such a file in Windows Explorer, the 
file will be opened in Word. You can use the same mechanism for Geonamica project 
files. However, if you have multiple versions of WISE installed or you have more than 
one Geonamica-based system installed on your computer, all of them will use the file 
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extension .geoproj for their project files. When you double-click on such a file, only one 
of these programs can be opened. 
 
When you open WISE, it checks whether Geonamica project files (with file extension 
.geoproj) are associated with this application and not another version or another 
Geonamica-based application. If this is not the case, WISE will do one of three things, 
controlled by the setting in the Preferences window. 

 If the „Do nothing‟ option is selected, the file association will be left as it is. 

 If the „Automatically associate‟ option is selected, the file association will be 
changed to open this application next time you double-click on a Geonamica 
project file. 

 If the „Ask me what to do‟ option is selected, a message window similar to the 
one depicted below will be displayed to indicate the possibly erroneous file 
association. In this window, you can select what to do by clicking one of the 
available buttons. If you select the „Don‟t ask me again‟ check box before 
clicking one of the buttons, the option in the Preferences window will be 
updated to reflect your choice. 

 

 
 

Raster map cache folder 

Some projects use maps that are larger than what can be safely stored in working 
memory. In these cases, the system needs to store calculated maps on the hard drive 
while a project is open. You can control where these maps are stored by changing the 
„Raster map cache folder‟ setting on the Preferences window. By default this is set to 
the Windows temporary files folder. When you open a project that has support for large 
raster maps enabled, you need to make sure that the selected folder is located on a 
hard disk with ample free space. 

5.5 Window menu 

You can use the Window menu to arrange or activate one of the opened windows in 
WISE. 
 

Option Function 

Cascade Arrange multiple opened windows in an overlapped fashion 

Tile horizontal Arrange multiple opened windows one above another in a non-
overlapped fashion 

Tile vertical Arrange multiple opened windows side by side in a non-
overlapped fashion 

Arrange icons Arrange the icons for minimized windows at the bottom of the 
screen 

List of Windows Active the selected window on the list of opened windows 

5.6 Help menu 

You can use the Help menu to open the integrated help functionality of WISE or to 
access troubleshooting information. 
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Option Function Link 

Index Open the integrated help functionality Section Help 

Licence Open the Licence window Section Licence 

Check for updates Check if a newer version of WISE is 
available 

Section Checking for 
updates 

About Open the About window Section About 

 
 
 



 

Doc # 2330707 Page 81 

Annex 1 WISE release history 

Version 1.3.0 (5 October 2012) 

 Added the Monte Carlo tool 

 Improved the user interface for the scenario manager to make it easier to use 

 Updated the district maps to show post-2010 boundaries 

 Updated the parameters of the population model 

 Allow part of the population to reside in non-residential areas; population 
densities have been adjusted accordingly 

 Added a sub-scenario with planned infrastructure improvements till 2020 

 Added Carbon Farming and Future Proof scenarios 

 Added functionality to export a project 

 Added support for GeoTIFF raster file format 

 Added inertia for vacant states 

 Various improvements to the way accessibility is calculated 

 Added zonal accessibility 

 Various minor user interface enhancements 

Version 1.2.0 (30 June 2011) 

 Improved the performance of the zoning tool 

 Changed the hydrology model to account for changes in land use 

 Fixed hydrology model parameters 

 Changed the link between the economic and land use model 

 Incorporated carbon forestry sectors in the economic model 

 Revised the user interface of the legend editor 

 Added scenario support to „log maps‟ functionality 

 Added download link for the Map Comparison Kit in the analysis section 

 Added an online version check 

 Changed license system (old licenses cannot be used anymore) 

Version 1.1.1 (3 November 2010) 

 Bug fixes 

Version 1.1.0 (17 August 2010) 

 Added „zoning tool‟ 

 Fixed computation of adjusted rates in population model 

 Password protected population parameter file 

 Fixed computation of change in final demand in economic supply model 

 Added support for addition and removal of infrastructure layers through the user 
interface 

 Added „land use indicators‟ displaying the difference between land use demand 
and allocated land over time 

 Support animation of river network maps and infrastructure network maps 

 Added integrated help functionality 

 Documented guidelines for best use of the scenario manager 

 Various user interface enhancements 
o Added „maps‟ menu 
o Added economic sector filter in policy user interface 
o Display overview of total potential figures for a single cell 
o Improved the „log maps‟ functionality 
o Made infrastructure policy measures more user-friendly 
o Removed „changes in inventories‟ from external factors 
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Version 1.0.7 (16 November 2009) 

 Updated hydrology parameters (maps) 

 Renamed “eco-efficiency” as “land productivity” 

Version 1.0.6 (11 November 2009) 

 Updated land use model parameters 

 Updated colours of land use map 

Version 1.0.5 (9 October 2009) 

 Changed simulation start year from 2004 to 2006 

 Updated initial land use map 

 Updated land use model parameters 

 Fixed implementation of population model 

 Updated population model parameters 

 Changed formula to compute average life expectancy 

 Changed allocation of residential land use functions from regional to district 
level 

 Added population density model 

 Added „decay coefficient‟ to economic supply model 

 Fixed drawing of output graphs 

 Display infrastructure networks on top of accessibility maps 

 Updated „About box‟ 

 Adopted „WISE‟ as the name of the system 

Version 1.0.4 (17 August 2009) 

 Changed marine land use from vacant to feature 

 Changed aquaculture land use from function to feature 

 Updated data for land use model and biodiversity model 

Version 1.0.3 (24 July 2009) 

 Replaced catchment map with catchment area lookup-table (water quality 
model) 

Version 1.0.2 (17 July 2009) 

 Incorporated hydrology model 

 Added social indicators 

 Updated „About box‟ 

Version 1.0.0 (10 July 2009) 

 Incorporated various sub-models: 
o Climate 
o Water quality 
o Population 
o Terrestrial biodiversity 

Version 0.5.1 (1 December 2008) 

 Added suitability maps 
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Version 0.5.0 (30 November 2008) 

 First prototype including land use and economic models 
 
 



 

 

 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 


